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Highlights

Centralized network
monitoring and visibility

Advanced threat and
vulnerability detection
with event and log data
correlation

Augmented NOC/SOC
operations for real-time
response, analytics, and
reporting

Automation to save
time, reduce errors, and
improve efficiency

Multi-tenancy solution
with quota management

Administrative domains
for operational
effectiveness and
compliance

70+ reports and 2000+
ready-to-use datasets,
charts, and macros
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Analytics, Reports, and Compliance Across the Security Fabric

FortiAnalyzer is a powerful log management, analytics, and reporting
platform that provides organizations with a single console to manage,
automate, orchestrate, and respond, enabling simplified security
operations, proactive identification and remediation of risks, and

complete visibility of the entire attack landscape.

Integrated with the Fortinet Security Fabric, FortiAnalyzer enables
Network and Security Operations Teams with real-time detection
capabilities, centralized security analytics and end-to-end security
posture awareness to help analysts identify advanced persistent

threats (APTs) and mitigate risks before a breach can occur.
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation Data Sheet

Capabilities

Incident Detection and Response

Centralized NOC/SOC Visibility for the Attack Surface

FortiAnalyzer provides Security Fabric Analytics across all device logs with event correlation
and real-time detection of Advanced Persistent Threats (APTs), vulnerabilities and Indicators
of Compromise (IOC) for FortiGate NGFWs, FortiClient, FortiSandbox, Fortiweb, FortiMail and
other Fortinet products, for deep visibility and critical network insights. Simplified orchestration
and automated workflows provide Network Security Operations teams with real-time
notifications, reports, and dashboards for single-pane visibility and actionable results.

Incidents and Events Management 12

Security teams can monitor and manage alerts and event logs from Fortinet devices, with
events processed and correlated in a format that analysts can easily understand. Investigate
suspicious traffic patterns and search using filters in predefined or custom event handlers to
generate real-time notifications and monitering for NOC and SOC operations, SD-WAN, SSL
VPN, wireless, Shadow IT, IPS, network recon, FortiClient, and more.

The Incidents component enables analysts to manage incident handling and life cycle, with
incidents generated by events that show affected assets, endpoints, users and timelines.

Fabric Automation

FortiAnalyzer Playbooks boost an organization’s security team abilities to simplify investigation
efforts through automated incident response, freeing up resources and allowing analysts to
focus on critical tasks. Out-of-the-box playbook templates enable SOC analysts to quickly
customize their use cases, define custom processes, interact with other Security Fabric
devices like FortiOS and EMS, edit playbooks and tasks in the visual playbook editor and use
the Playbook Monitor for investigation of compromised hosts, infections and critical incidents,
data enrichment for Assets and ldentity views, blocking malware, C&C IPs, and more.

Security Fabric Analytics

Analytics and Reporting

FortiAnalyzer automation driven analytics empowers network security operations teams to
complete a fast assessment of network devices, systems, and users, with correlated log data
and FortiGuard threat intelligence for analysis of real-time and historical events.

o  FortiView Monitors and Views provide deep insights with context and meaning of network
activity, risks, vulnerabilities, attack attempts, indicators of compromise and anomalies,
sanctioned and unsanctioned user activity.

« Log View enables analysts to expand their investigation and utilize search filters on
managed device logs, drill down on logs, with custom views and log groups, including a
SIEM database with normalized logs for Fortinet devices in Fabric ADOMs.

« Reports provide comprehensive analysis of your Security Posture, including reports for
Operational Technology (OT), security rating, security rating for PCI, Secure SD-WAN, VPN,
FortiNDR network anomaly detection, cyber threat assessments, 360 Security Reviews,
situational awareness, compliance, auditing, and more.




FortiAnalyzer™ - Security Fabric Network Analytics and Automation Data Sheet

Capabilities

Assets and Identity

FortiAnalyzer Fabric View with Assets and Identity monitoring provides SOC teams with
elevated awareness and visibility into an organization’s endpoints and users with dashboards
and correlated device and UEBA information, vulnerability detections, EMS tagging, and asset
classifications through telemetry with EMS, NAC, Fortinet Fabric Agent, and an OT Dashboard
View.
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation Data Sheet

Subscriptions and Extensions

Subscription Licenses and FortiGuard Security Services

o FortiGuard Outbreak Detection Service delivers automated content package download
for detecting the latest malware, including a summary of outbreaks and kill chain mapping
for how the malware works. The package includes a FortiGuard Report for the outbreak,
Event Handler, and a Report Template to detect outbreaks.

«  FortiGuard Indicators of Compromise Service empowers security teams with forensic
data from 500 000 IOCs daily, used in combination with FortiAnalyzer analytics to identify
suspicious usage and artifacts observed on the network or in an operations system, that
have been determined with high confidence to be malicious infections or intrusions, and
historical rescan of logs for threat hunting.

« Shadow IT Monitoring Service provides continuous monitoring of unapproved devices,
resources, unsanctioned accounts and unauthorized use of Saa$S and laaS, APl integration,
and third party apps. The service identifies rogue users using personal accounts for
managing company assets, using correlated FortiOS and FortiCASB data with a FortiCASB
account subscribed for Saas features.

e OT Security Service provides security teams with advanced OT analytics, risk and
compliance reports, OT event handlers, and use-case correlation rules.

«  Security Rating and Compliance Service helps security teams design, implement, and
maintain their security posture, and provides actionable configuration recommendations as
well as key performance and risk indicators.

e Security Automation Service subscription enables further automation for incident
response with enhanced monitoring and escalation, built-in incident management
workflows, connectors, playbooks and more.

Management Extension Applications (MEAs)

The Management Extensions pane allows you to enable licensed applications that are
released and signed by Fortinet, which can be installed and run on FortiAnalyzer, including the
FortiSIEM and FortiSOAR.
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation Data Sheet

Deployments
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Deploying FortiAnalyzer

FortiAnalyzer can be deployed as a physical hardware appliance, virtual machine (VM) and
virtual machine subscription (VM-S), as well as private or public cloud instance, with scalability,
redundancy and backup, and high availability capabilities.

FortiAnalyzer High Availability (HA)

FortiAnalyzer HA provides real-time redundancy to protect organizations by ensuring
continuous operational availability. In the event that the primary (active) FortiAnalyzer fails,
a secondary (passive) FortiAnalyzer (up to four-node cluster) will immediately take over,
providing log and data reliability and eliminating the risk of having a single point of failure.

Multi-Tenancy with Flexible Quota Management

FortiAnalyzer provides the ability to manage multiple sub-accounts with each account
having its own administrators and users. The time-based archive/analytic log data policy, per
Administrative Domain (ADOM), allows automated quota management based on the defined
policy, with trending graphs to guide policy configuration and usage monitoring.

Analyzer Collector Modes

FortiAnalyzer provides two operation modes: Analyzer and Collector. In Collector mode, the
primary task is forwarding logs of the connected devices to an Analyzer and archiving the logs.
This configuration greatly benefits organizations with increasing log rates, as the resource
intensive log-receiving task is off-loaded to the Collector so that the Analyzer can focus on
generating analytics and reports.

Network operations teams can deploy multiple FortiAnalyzers in Collector and Analyzer modes
to work together to improve the overall performance of log receiving and processing increased
log volumes, providing log storage and redundancy, and rapid delivery of critical network and
threat information.

FortiAnalyzer Fabric

FortiAnalyzer Fabric allows SOC Administrators to configure two operation modes - Supervisor
and Member. This allows viewing of member devices, ADOMs and authorized logging devices,
as well as incidents and events created on members. Admins get access to Reports and
FortiView across all member FortiAnalyzers, and can perform global search in Log View of logs
collected across FortiAnalyzer Fabric members with pre-defined device filters and log drill
down for each Member and Member ADOMs.

Log Forwarding for Third-Party Integration

Forward logs from one FortiAnalyzer to another FortiAnalyzer unit, a syslog server, or (CEF)
server. In addition to forwarding logs to another unit or server, the client FortiAnalyzer retains a
local copy of the logs, which are subject to the data policy settings for archived logs. Logs are
forwarded in real-time or near real-time as they are received from network devices.
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Cloud Services

FortiAnalyzer Cloud

FortiAnalyzer Cloud offers customers a PaaS-based delivery option for automation-driven, single pane analytics, providing
log management, analytics, and reporting for Fortinet NGFW and SD-WAN with an easily accessible cloud-based solution.
FortiAnalyzer Cloud delivers reliable real-time insights into network activity with extensive reporting and monitering for clear,
consistent visibility of an organization’s security posture. Customers can easily access their FortiAnalyzer Cloud from their
FortiCloud single sign-on portal.

Virtual Offerings

FortiAnalyzer VM Subscription

The FortiAnalyzer VM Subscription license model consolidates into one single SKU: VM product SKU, FortiCare Support SKU,
FortiGuard I0C and Outhreak Detection Service, Security Automation services, to simplify the product purchase, upgrade,

and renewal. FortiAnalyzer-VM S provides organizations with centralized security event analysis, forensic research, reporting,
content archiving, data mining, malicious file quarantining, and vulnerability assessment. Centralized collection, correlation, and
analysis of geographically and chronologicelly diverse security data from Fortinet and third party devices deliver & simplified,
consolidated view of your security posture.

The FortiAnalyzer-VM S series SKUs come in stackable 5, 50, and 500 GB/ day logs licenses, so that multiple units of this SKU
can be purchased together providing organizations with the ability and cost-efficiencies to scale and meet their logging needs.
FortiAnalyzer VM

Fortinet offers the FortiAnalyzer-VM licensing in a stackable perpetual license model with a-la-carte technical support and
subscription services.

This software-based version of the FortiAnalyzer hardware appliance is designed to run on many virtualization platforms, which
allows you to expand your virtual solution as your environment expands.

FORTIANALYZER VIRTUAL APPLIANCES FAZ-VM-GRB1 FAZ-V'M-GBS FAZ-VM-GB25 FAZ-VM-GB100O FAZ-VM-GBBRO  FAZ-VM-GB20G0
Capacity
GB/ day of Logs * +1 +5 +25 +100 +500 42000
Devices/VDOMs Maximum 10 000 10 000 10 000 10 000 10 000 10 000
FortiGuard IQC Service @
Security Automation Service @
Hypervisor Support Up-to-date hypervisor support can be found in the release note for each FortiAnalyzer version.
Visit https://docs.fortinet.com/product/fortianatyzer/ and find the Release Information at the bottom section

Go to "Product Integration and Support” = “FortiAralyzer [version] support” = “Virtualization”
vCPU Support (Minimum / Maximum) 4/ Unlimited
Network Interface Support (Min / Max) ™ 1/12
Memary Support (Minimum / Maximum) 16 GB / Unlimited for 64-bit

* Unlimited GB/ day when deployed in collector mode

** VM supports up to 12 vNIC interfaces/ports. Applicable to 6.4 3+. Actual consumable numbers vary depending on cloud platforms

ey

pdr




FortiAnalyzer™ - Security Fabric Network Analytics and Automation

Data Sheet

Specifications
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FORTIANALYZER APPLIANCES FAZ-1506 FAZ-300G FAZ-810G FAZ-1000G

Capacity and Performance

GB/ day of Logs 25 100 200 660

ls\:(::i)lzlic Sustained Rate (logs/ 500 2000 4000 20000

o s’

f:;;';c’" Sustained Rate(logs 750 3000 5000 | 1-7 30 000

Devices/VDOMs {Maximum) 50 180 800 2000

Max Number of Days Analytics** 90 50 50 50

Options

FortiGuard I0C and Outbreak

Detection Service @ @ @ @

Security Automation Service @ @ @ @

Enterprise Bundle @ @ @ @

Hardware Bundie @ @ @ @

OT Security Service @ @ @ @

Security Rating and Compliance

Service @ @ @ @

Hardware Specifications

Form Factor (supports EIA/non- Desktop 1 RU Rackmount 1RU Rackmount 2 RU Rackmount

ElA standards) 4N

Total Interfaces 2x RJ45 GE 4x RJ45 GE i—‘) 4x RJ-45 2x GE SFP 2% 2.5GbE RJ45 + 2% 25GbE SFP28

Storage Capacity 4ATB (2% 2TB) 8 TB(2x 4 TB) 16TB (4x 4TB) 3.5 in SAS HDDs 32 TB (8 x 4TB) 3.5 in SAS SED
. HDD

Usable Storage {After RAID) 27TB 478 4 _4 87TB 24 7TB

Removable Hard Drives No No @ ©

RAID Levels Supported on RAID 0/1 1—4 RAID 0/1,1s/5,5s10 RAID 0/1/5/6/10/50/60

RAID Type Software Software Hardware / Hot Swappable Hardware / Hot Swappable

Default RAID Level 1 1 10 50

Redundant Hot Swap Power No Optional .

Supplies Optional @)

Trusted Platform Moduie (TPM) *** Gen 2 Gen 2 @ ©)

Dimensions

Height x Width x Length (inches) 95x35x8 1.73 x 17.24 x 16.38 1.73 x 17.32 x 21.85 3.46 x 1724 x 24.41

Height x Width x Length {cm)
Weight

Environment

AC Power Supply

241 x8.9x 2055
9.35 Ibs (4.24 kg)

100-240V AC, 50-G0 Hz

4.4 %438 x 416
22.5 Ibs (10.2 kg)

100-240V AC, 60-50 Hz

4.4 x44.0 %550
25.75 Ibs (11.68 kg)

100-240Vac, 50~60Hz, 4A max

8.8 x 438 x 62.0
496 Ibs (22.5 kg)

100-240Vac, 50~60Hz, 4A max

Power Consumption (Average / 36 W /43 W S01W/sewW 115W / 150W 251.36W / 302W
Maximumy)
Heat Dissipation 147.4 BTU/h 3378 BTU/h 433 BTU/h 85773 BTU/h

Operating Temperature
Storage Temperature
Humidity

Forced Airflow

Operating Altitude

Compliance

32°F t0 104° F (0°C to 40° C)
-4°F t0 167° F (-20°C to 75° C)
5% to 95% non-condensing

Front to Back

Up to 7400 ft (2250 m)

32°F t0 104° F (0°C 10 40° C)
-13°F 0 167° F (-25°C to 75° C)
20% to 90% non-condensing

Front to Back

Up to 7400 ft (2250 m)

32°F t0 104° F (0°C to 40° C)
-4°F 10 167° F (-20°C to 76° C)
5% to 95% non-condensing

Front to Back

Up to 7400 ft (2250 m)

32°F 10 104° F (0°C to 40° C)
-40°F to 158° F (-40°C to 70° C)
5% to 85% non-condensing

Front to Back

Up to 16 404 ft (5000 m)

FCC Part 15 Class A, RCM, VCCI,
CE, ULicUL, CB

FCC Part 15 Class A, RCM, VCCI,
CE, BSMi, KC, UL/cUL, CB, GOST

FCC Part 15 Class A, RCM, VCCI,
CE, UL/cUL, CB

FCC Part 15 Class A, RCM, VCCI,
CE, UL/cUL, CB

* Sustained Rate - maximum constant log message rate that the FAZ piatform can maintain for minimum 48 hours without SQL database and system performance degradation

Safety Certifications

** The maximum number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate is lower

*** Gen2 refers to hardware that has been upgraded since initial release.
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation

Data Sheet

Specifications

FORTIANALYZER APPLIANCES
Capacity and Performance
GB/ day of Logs

Analytic Sustained Rate
(logs/sec)*

Coliector Sustained Rate
(logs/sec)*

Devices/VDOMs (Maximum)
Max Number of Days Analytics**

Options

FortiGuard I0C and Outbreak Detection

Service

Security Automation Service
Enterprise Bundle

Hardware Bundle

OT Security Service

Security Rating and Compliance Service

Hardware Specifications

Form Factor (supports EI&/non-EIA
standards)

Total Interfaces

Storage Capacity

Usable Storage (After RAID)
Removable Hard Drives

RAID Levels Supported

RAID Type

Default RAID Level

Redundant Hot Swap Power Supplies
Trusted Platform Module (TPM) ***
Dimensions

Height x Width x Length (inches)
Height x Width x Length (cm)
Weight

Environment

AC Power Supply

Power Consumption (Average/Max)
Heat Dissipation

Operating Temperature

Storage Temperature

Humidity

Forced Airflow

Operating Altitude

Compliance

Safety Certifications

FAZ-3100G

3000

42 000

60 000

4000
30

QOO ©

3 RU Rackmount

2x GE RJ45, 2% 25GE SFP28

64 TB (16 » 4TB) 3.5" SAS SED HDD + 3.84

(2x 1.92TB) 2.5" NVMe SSD
56 TB

@

RAID
0/1,1s/5,55/6,65/10/50/60

Hardware / Hot Swappable
50

52 %172 %255
130 x 44.0 x 650
69.6 Ibs (31.57 kg)

100-127V~/10A, 200-240V~/5A
395 W /510 W
174039 BTU/h
32°F to 104°F (0°C to 40°C)
-4°F to 158°F (-20°C to 70°C)
5% to 95% (non-condensing)
Front to Back
Up t0 13 123 ft (4000 m}

FCC Part 15 Class A, RCM, VCCI, CE, UL,

cUL, CB

FAZ-2510G

5000

60 000

90 000

10 000

GICICICICONG)

4 RU Rackmount

2» 10GbE RJ45, 2x 25GhE SFP28
24x 4TB (96TB) + 2% 3.84TB (7.68TB)

84718

©

RAID
0/11s/5,55/6,65/10/50/60

Hardware / Hot Swappable
50

©
©

7x172x275
17.8 x 437 x 69.9
65 Ibs (295 kg)

100-127V~/10A, 200-240V~/5A
983 W /1278 W
3424 BTU/h
32°F to 104°F (0°C to 40°C)
-4°F t0 167°F (-20°C to 75°C)
5% to 95% (non-conaensing)
Front to Back

Up to 10 000 ft (3048 m)

FCC Part 15 Class A, RCM, VCCI, CE, UL/

cUL, CB

FAZ-B3700G

8300

100 000

150 000

10 000
60

QOO ©

4 RU Rackmount

2% 10GE RJ-45 + 2x 25GE SFP28
240TB (60x 4TB) 3.51n HDD + 19.2T8B

(6% 3.2TB) NVMe SSD
224 7B

©

RAID
0/115/5,5s.:6,65/10/50/60

Hardware / Hot Swappable

50

©
©

70 x 172 x 30.2
17.8 x 43.7 % 76.7
118 Ibs (53.5 kg)

2000W ACH#**
850 W /14234 W
4858 BTU/h
50°F to 95°F (10°C to 35°C)
-40°F to 158°F (~40°C to 70°C})
8% to 90% (hon-condensing)
Front to Back
Up to 7400 ft {2250 m)

FCC Part 15 Class A, RCM, VCCI, CE, UL/

cUL, CB

* Sustained Rate - maximum corstant log message rate that the FAZ platform can maintain for minimum 48 hours without SQL database and system performance degradation.

** |s the max number of days if receiving logs continuously at the sustained analytics log rate. This number can increase If the average log rate is lower.

**¥ Gen2 refers to hardware that has been upgraded since initial release

****3700G must connect to a 200V - 240V power source.




FortiAnalyzer™ -

Security Fabric Network Analytics and Autcmation

Data Sheet

Ordering Information

Product

FortiAnalyzer

FortiAnalyzer-VM Subscription
License with Support

FortiAnalyzer-VM

FortiAnalyzer Cloud Storage
Subscription

FortiAnalyzer - Backup to Cloud
Service
FortiAnalyzer Cloud with SOCaaS

FortiAnalyzer Cloud

Security Automation Service

FortiGuard IOC and Outbreak
Detection Service

OT Security Service

FortiAnalyzer Security Rating and
Compliance Service

Enterprise Protection Bundle

Hardware Bundie

SKU

FAZ-150G
FAZ-300G
FAZ-810G

FAZ-1000G

FAZ-3100G

FAZ-3510G

FAZ-3700G

FC1-10-AZVMS-465-01-DD

FC2-10-AZVMS-465-01-DD

FC3-10-AZVMS-465-01-DD

FAZ-VM-GB1
FAZ-VM-GB5
FAZ-VM-GB25
FAZ-VM-GB100
FAZ-VM-GB500

FAZ-VM-GB2000
FC1-10-AZCLD-463-01-DD

FC2-10-AZCLD-463-01-DD

FC3-10-AZCLD-463-01-DD

FC-10-FAZ00-286-02-DD

FC-10-[Model Code]-464-02-DD

FC-10-[Model Code]-585-02-DD

FC-10-[Model Code]-335-02-DD

FCIGB Day Code]-10-LVOVM-335-02-DD

FC-10-[Model Code]-661-02-DD

FCIGB Day Code]-10-LVOVM-661-02-DD

FC-10-[Model Code]-159-02-DD

FC-10-[Model Code]-175-02-DD

FC-10-[Model Code]-466-02-DD

FAZ-[Hardware Model]-BDL-466-DD

Description
Centralized log and analysis appliance — 2x RJ45 GE, 4 TB storage, up to 25 GB/ day of logs.
Centralized log and analysis appliance — 4x RJ45 GE, 8 TB storage, up to 100 GB/ day of logs

Centralized log and analysis appliance — 4x GE, 2x SFP, 16 TB self-encrypting storage, up to
200 GB/ day of logs

Centralized logging and analysis appliance - 2x 2.5GbE RJ45 + 2% 25GbE SFP28, 32TB storage, up to
660 GB.Day of Logs.

Centralized log and analysis appliance — 2x GE RJ45, 2x 25GE SFP28, 64 TB sterage, dual power
supplies, up to 3000 GB/ day of logs

Centralized log and analysis appliance — 2x 10GbE RJ45, 2x 25GbE SFP28, 96 TB storage, up to
5000 GB/ day of logs.

Centralized log and analysis appliance - 2x 10GE RJ-45 + 2x 25GE SFP28 slots, 2407B HDD + 19.2TB
NVMe SSD storage, up to 8300 GB/ day of Logs

Subscription license for 5 GB/Day Central Legging and Analytics include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Outbreak Detection service

Subscription license for 50 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Outbreak Detection service.

Subscription license for 500 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
I0C, Security Autcmation Service, and FortiGuard Outbreak Detection service.

Upgrade license for adding 1 GB/Day of Logs
Upgrade license for adding 5 GB/Day of Logs.
Upgrade license for adding 25 GB/Day of Logs.
Upgrade license for adding 100 GB/Day of Logs
Upgrade license for adding 500 GB/Day of Logs

Upgrade license for adding 2 TB/Day of Logs.

Increase FortiAnalyzer Cloud storage by 5 GB/Day for Central Logging and Analytics and FortiCloud
SOCaa$ Include ForuCare Premium support, IOC and Security Automation Service

Increase FortiAnalyzer Cloud storage by 50 GB/Day for Central Logging and Analytics and FortiCloud
SOCaas. Include FortiCare Premium support, IOC and Security Automation Service.

Increase FortiAnalyzer Cloud storage by 500 GB/Day for Central Logging and Analytics and FortiCloud
SOCaa$ Include FortiCare Premium support, IOC and Security Automation Service

One year subscription to FortiAnalyzer storage connector service for 10TB data transfer to public cloud

FortiAnalyzer Cloud with SOCaa$S: cloud-based central logging and analytics. Include All FortiGate log
types, IOC service, Security Automation Service, FortiGuard Outbreak Service and SOCaasS.

FortiAnalyzerCloud: cloud-based central logging and analytics Include all FortiGate log types, 10C
service, Security Automation Service, FortiGuard Outkreak Detection Service.

Subscription license for Security Automation Service - Appliance.

Subscription license for Security Automation Service - Virtual Machine

Subscription license for FortiGuard 10C and Outbreak Detection Service - Appliance
Subscription license for FortiGuard I0C and Outbreak Detection Service - Virtual Machine

OT Security Service including advanced OT analytics, risk and compliance reports, event handlers, and
use-case correlation rules.

Subscription license for FortiAnalyzer Security Rating and Compliance Service.
Enterprise Protection (FortiCare Premium plus Indicators of Compromise Service, Security Automation

Service, and FertiGuard Outbreak Detection service).

Hardware plus FortiCare Premium and FortiAnalyzer Enterprise Protection

Wm“ﬂ
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Fortinet Corporate Social Responsibility Policy

Fortinet is committed to driving progress and sustainability for all through cybersecurity, with respect for human rights and
ethical business practices, making possible a digital world you can always trust. You represent and warrant to Fortinet that you
will not use Fortinet’s products and services to engage in, or support in any way, violations or abuses of human rights, including
those involving illegal censorship, surveillance, detention, or excessive use of force. Users of Fortinet products are reqguired

to comply with the Fortinet EULA and report any suspected violations of the EULA via the procedures outlined in the Fortinet
Whistleblower Policy.
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Log View and Log Quota Management

You can view log information by device or by log group.

When rebuilding the SQL database, Log View is not available until the rebuild is complete.
Click the Show Progress link in the message to view the status of the SQL rebuild.

When ADOMs are enabled, each ADOM has its own information displayed in Log View.

Log View can display the real-time log or historical (Analytics) logs.
Log Browse can display logs from both the current, active log file and any compressed log files.

For more information, see Analytics and Archive logs on page 42.

Types of logs collected for each device

1-0

FortiAnalyzer can collect logs from the following device types: FortiADC, FortiAnalyzer, FortiAuthenticator, FortiCache,
FortiCarrier, FortiCASB, FortiClient, FortiDDoS, FortiDeceptor, FortiEDR, FortiGate, Fortilsolator, FortiMail,
FortiManager, FortiNAC, FortiNDR (formerly FortiAl), FortiPAM, FortiProxy, FortiSandbox, FortiSOAR, FortiWeb, and
Syslog servers. Following is a description of the types of logs FortiAnalyzer collects from each type of device:

Fabric All
FortiADC Event, Intrusion Prevention, Traffic
FortiAnalyzer Event, Application

FortiAuthenticator Event

FortiGate Traffic

Security: Antivirus, Intrusion Prevention, Application Control, Web Filter, File Filter, DNS,
Data Loss Prevention, Email Filter, Web Application Firewall, Vulnerability Scan, VolIP,
FortiClient

Event: Endpoint, HA, Compliance, System, Router, VPN, User, WAN Opt. & Cache, WiFi

- ! ! File Filter logs are sent when the File Filter sensor is enabled in the
9 FortiOS Web Filter profile. You can enable the File Filter sensorin
= FortiOS at Security Profiles > Web Filters.
FortiCache Traffic, Event, Antivirus, Web Filter
FortiCarrier Traffic, Event, GTP
FortiAnalyzer 7.4.3 Administration Guide foe = o 129

Fortinet Inc.

b P s ety




Appendix B - Log Integrity and Secure Log Transfer

To query the log file's MD5 checksum in the CLI:

1. Enterthe following command in the FortiAnalyzer CLI:
execute log-integrity <device name> <vdom name> <log name>
For example:
execute log-integrity FGVMO1TM20000000 root tlog.1608279204.log.gz
Integrity checking passed:
MD5 checksum is [82598ec0086319db73bd0£9de2396047]

Secure Log Transfer

1

(3]

Optimized Fabric Transfer Protocol (OF TP) is a proprietary Fortinet protocol. It is used for connectivity, performing
health checks, file transfers, and log display on FortiGate. OF TP listens on ports TCP514 and UDP514.

In the default configuration, there are two communication streams between FortiGate and FortiAnalyzer.
OFTP communication is encrypted and log communication is not.

o OFTP communication occurs on TCP514 using TLS.
o Log communication occurs on UDP514 (default setting).

Default FortiGate Settings

OFTP - TCP514 (TLS)
< ’/\

-

Log - UDP514

To secure log transfer, you can enable TCP and encryption. When enabled, logs are transferred securely between the
FortiGate and FortiAnalyzer using TCP514 (TLS).

Secure Log Transfer

/// e P OFTP - TCP514 (TLS)

Log - TCP514 (TLS)

Configuring secure log transfer settings

Reliable logging from FortiGate to FortiAnalyzer prevents lost logs when the connection between FortiGate and
FortiAnalyzer is disrupted. If connection is lost between the FortiAnalyzer and FortiGate device, logs will be cached and
sent to FortiAnalyzer once the connection resumes.

For more information, see FortiAnalyzer log caching in the FortiGate / FortiOS Administration Guide.

FortiAnalyzer 7.4.3 Administration Guide
Fortinet Inc.
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Reports

[
I

You can generate data reports from logs by using the Reports feature. You can do the following:

» Use predefined reports. Predefined report templates, charts, and macros are available to help you create new
reports.

« Create custom reports.

Report files are stored in the reserved space for the FortiAnalyzer device. See Automatic deletion on page 150.
When rebuilding the SQL database, Reports are not available until the rebuild is completed.
Select the Show Progress link in the message to view the status of the SQL rebuild.

For more information on FortiAnalyzer report technology and troubleshooting report performance issues, see the
FortiAnalyzer Report Performance Troubleshooting Guide.

How ADOMs affect reports

When ADOMs are enabled, each ADOM has its own reports, libraries, and advanced settings. Make sure you are in the
correct ADOM before selecting a report. See Swiiching between ADOMs on page 31.

Some reports are available only when ADOMs are enabled. For example, ADOMs must be enabled to access
FortiCarrier, FortiCache, FortiClient, FortiDDoS, FortiMail, FortiSandbox, and FortiWeb reports. In a Security Fabric
ADOM, all reports are displayed.

You cannot import reports to ADOMs that do not match the device type used in the charts and datasets for the report.
Fabric ADOMs support all reports, regardless of the device type used in the charts and datasets. For example, a
FortiGate report cannot be imported to an ADOM for a different device type; it can only be imported to a FortiGate or
Fabric ADOM.

You can configure and generate reports for these devices within their respective default ADOM or a Security Fabric
ADOM. These devices also have device-specific charts and datasets.

ADOM limits for reports

The following table identifies FortiAnalyzer ADOM limits for reports.

Chart 5000
Dataset 5000
Macro 5000
Layout 2000

FortiAnalyzer 7.4.3 Administration Guide
Fortinet inc.
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Reports

Step 2: Initiate a rebuild of hcache tables

To initiate a rebuild of hcache tables, enter the following CLI command:

diagnose sgl hcache rebuild-report <start-time> <end-time>

Where <start-time>and <end-time> are in the format: <yyyy-mm-dd hh:mm:ss>.

Retrieving report diagnostic logs

Once you start to run a report, FortiAnalyzer creates a log about the report generation status and system performance.
Use this diagnostic log to troubleshoot report performance issues. For example, if your report is very slow to generate,
you can use this log to check system performance and see which charts take the longest time to generate.

For information on how to interpret the report diagnostic log and troubleshoot report performance issues, see the
FortiAnalyzer Report Performance Troubleshooting Guide.

To retrieve report generation logs:

1. In Reports > Generated Report, right-click the report and select Retrieve Diagnostic to download the log to your
computer.

2. Use atext editor to open the log.

Auto-Generated Reports

The Cyber Threat Assessment report is automatically generated. By default, the report will run at 3:00AM every Monday.
For more information on report scheduling, see Scheduling reports on page 276.

Schedules can be viewed in the Report Calendar. See Report calendar on page 312.

vy
‘9' This will only affect newly installed FortiAnalyzer or newly created ADOM. Upgraded ADOM
- | reports, scheduling and calendar will be kept as is.
Scheduling reports 1-7

You can configure a report to generate on a regular schedule. Schedules can be viewed in the Report Calendar. See
Report calendar on page 312.

To schedule a report:

Go to Reports > Report Definitions > All Reports.

Select a report and click Edit in the toolbar.

Click Settings in the toolbar.

Select the Enable Schedule checkbox and configure the schedule.
Click Apply.

L

FortiAnalyzer 7.4.3 Administration Guide
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Repbrts -

-

To create output pi‘ofiles:

1. Ifusing ADOMs, en;.lj're thatyou are in the correct ADOM.
2. Goto Reports > Advanced Settings > Output Profile.
3. Click Create New. The Create Output Profile pane is displayed.

Create Output Profile

Name

Comments

Qutput Format

B Email Generated Reports

Subject

Body

071023

Recipients Email Server

O HTML {3 POF

OxML O csv O JSON

From To

Clicx here te add new entry

B Ubload Report to Server

Server Type FTP
Server
User
Password
Directory

[ Delete file(s) after uploading

Cancel

4. Provide the following information, and click OK:

Name
Comments

Output Format

Email Generated Reports
Subject
Body

Recipients

Upload Report to Server
Server Type
Server
User
Password

Directory

FortiAnalyzer 7.4.3 Administration Guide
Fortinet Inc.

Enter a name for the new output profile.

bt

7
=l

Enter a comment about the output profile (optional).

Select the format or formats for the generated report. You can choose HTML,
PDF, XML, CSV, or JSON format.

Enable emailing of generated reports.
Enter a subject for the report email.
Enter body text for the report email.

Select the email server from the dropdown list and enter to and from email
addresses. Click Add to add another entry so that you can specify multiple
recipients.

Enable uploading of generated reports to a server.
Select FTP, SFTP, or SCP from the dropdown list.
Enter the server IP address.

Enter the username.

Enter the password.

Specify the directory where the report will be saved.
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Log View and Log Quota Management

Security: Summary dashboard:

Toggle Widgets v All Devices v @ Last 1 Hour v

AntiVirus

Top Virus/Botnet &

EICAR

FILE

VEA.

_ﬁf' Intrusion Prevention

Top Attack &

ME SMS Server SMB1 MIDFIC.Parsic

Event: Summary dashboard:

Action
blocked

biocked

Action £

dropped

Count =

240

2023-04-06 12:02:00 - 2023-04-06 13.02:00

Top Category

Application Control

Action & Count < H
pass 0410 —
pass 16460 omem— i
|
379 m l
1725 B f
sass wos  ®
pass 1126 ©
0% 10
Count
s

The summary dashboard for event logs includes a Total Events widget, which displays a line chart of the event logs by
level. You can hover your cursor over the line chart to display a summary of the count and time at that point. This widget
cannot be toggled off.

Togge Widpets v AiDavices v @ Lant 4 bours ~ 20230329 1244

Total Events

0

20230329 16:1600

Viewing historical and real-time logs

By default, Log View displays historical logs. Custom View and Chart Builder are only available in historical log view.

To view real-time logs, in the log message list view toolbar, click Tools > Real-time Log.

To switch back to historical log view, click Tools > Historical Log.

FortiAnalyzer 7.4.3 Administration Guide
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FortiView dashboards for FortiGate and FortiCarrier devices

Category View

Top Threats

- Threat Map

' Threats

Indicator of
Compromise

& . FortiSandbox
Detection

FortiAnalyzer 7.4.3 Administration Guide
Fortinet inc.

Description

Lists the top threats to your network.
The following incidents are considered threats:
» Risk applications detected by application control.
e Intrusion incidents detected by IPS.
¢ Malicious web sites detected by web filtering.
¢ Malware/botnets detected by antivirus.

Displays a map of the world that shows the top traffic destinations starting
at the country of origin. Threats are displayed when the threat score is
greater than zero and either the source or destination IP is a public IP
address.

The Threat Window below the map, shows the threat, source, destination,
severity, and time. The color gradient of the lines indicate the traffic risk. A
yellow line indicates a high risk and a red line indicates a critical risk.

This view can be filtered by device, time, source, and destination. See also
Viewing the threat map on page 90.

Displays end users with suspicious web use compromises, including end

users’ IP addresses, overall threat rating, and number of threats.

To use this feature:

1. UTM logs of the connected FortiGate devices must be enabled.

2. The FortiAnalyzer must subscribe to FortiGuard to keep its threat
database up-to-date.

. Displays a summary of FortiSandbox related detections.

The following information is displayed: Filename, End User and/or IP,
Destination IP, Analysis (Clean, Suspicious or Malicious rating), Action
(Passthrough, Blocked, etc.), and Service (HTTP, FTP, SMTP, etc.).

Select an entry to view additional information in the drilldown menu.
Clicking a FortiSandbox action listed in the Process Flow displays details
about that action, including the Overview, Indicators, Behavior Chronology
Chart, Tree View, and more. Information included in the Details and Tree

 Viewtabis only available with FortiSandbox 3.1.0 and above.
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Category

SSL & Dialup IPsec

' VPN
Site-to-Site IPsec
Admln Logrns
System Events
1-& | System Resource Usage

Failed
Authentication
Attempts

Using FortiView

Displays the users who are accessing the network by using the following

Description

types of security over a virtual private network (VPN) tunnel: secure socket
layers (SSL) and Internet protocol security (IPsec).

You can view VPN traffic for a specific user from the top view and drilldown
views. In the top view, double-click a user to view the VPN traffic for the
specific user. In the drilldown view, click an entry from the table to display
the traffic Iogs that match the VPN user and the destination.

Dlsplays the names of VPN tunnels W|th Internet protocol security (IPsec)
thatare accessmg the network

Dlsplays the users who Iogged mto the managed devrce

Dlsplays events on the managed devtce

Displays devrce CPU memory, Iogglng and other performance
information for the managed device.

Resource Usage includes two widgets: Resource Usage Average and
Resource Usage Peak.

5 Displays the IP addresses of the users who failed to log into the managed

device.

When ADOM s are enabled, FortiView displays information for each ADOM. Please ensure you are in the correct ADOM.
See Switching between ADOMs on page 31.

« Viewing FortiView dashboards on page 89

« Filtering FortiView on page 92

« Creating custom views for FortiView on page 93

« Viewing related logs on page 94

« Exporting filtered summaries on page 95
« Monitoring resource usage of devices on page 25

« Long-lived session handling on page 95

Viewing FortiView dashboards

When viewing FortiView dashboards, use the controls in the toolbar to select a device, specify a time period, refresh the

view, and switch to full-screen mode.

Many widgets on FortiView dashboards let you drill down to view more details. To drill down to view more details, click,
double-click, or right-click an element to view details about different dimensions in different tabs. You can continue to drill
down by double-clicking an entry. Click the close icon in the widget's toolbar to return to the previous view.

FortiAnalyzer 7.4.3 Administration Guide
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Incidents & Events

Export to CSV

Column Settings

Default event views

You can specify a refresh interval of Every 10 Seconds, Every 30 Seconds, Every
1 Minute, or Every 5 Minutes.

Download the events to a CSV file.

Select which columns are displayed in the All Events pane. Columns not
displayed by default include

Acknowledged, Acknowledged By, Acknowledged Time, Assigned To, Comment,
Commented By, Commented Time, Device ID, Device Type, Event ID, Group By,
Group By 2, Group By 3, Indicators, Last Occurence, and VDOM Name.

1
|-

w

FortiAnalyzer event handlers apply one or more tags to events, allowing the events to be grouped into views in the Event
Monitor. These views are visible in the navigation.

Default views are organized into three view categories under Incidents & Events > Event Monitor:

o By Endpoint. Provides security event views from an endpoint perspective.
o By Threat: Provides security event views from a threat perspective.
« System Events: Provides event views which cover device system events.

In order for events to be displayed in default views, the corresponding event handler(s) must be enabled. Refer to the
chart below for a list of the predefined event handlers that must be enabled to support each default view:

View category

By Endpoint

Default view
All Security Events

Compromised Hosts

Sandbox Detections

Malware Activity

Ongoing Intrusions
Malicious Domain/URL Access

High Risk App Usage

FortiAnalyzer 7.4.3 Administration Guide

Fortinet Inc.

Required predefined event handler
Displays all events within category with enabled handlers

Default-Botnet-Communication-Detection-By-Endpoint
Default-Compromised Host-Detection-IOC-By-Endpoint

Default-Sandbox-Detections-By-Endpoint

Default-Sandbox-Detections-By-Endpoint
Default-Malicious-File-Detection-By-Endpoint

Default-Malicious-Code-Detection-By-Endpoint
Default-Risky-Destination-Detection-By-Endpoint
Default-Risky-App-Detection-By-Endpoint
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Incidents & Events

Creating notification profiles 1-9

Notification profiles are used to send alert notifications when an event is generated by an event handler. You can
configure the natification profile to send the alert to an email address, SNMP community, and/or syslog server. You can
also configure the notification profile to send the alert through a fabric connector.

You can create, edit, clone, and delete notification profiles in /ncidents & Events > Handlers > Notification Profiles.
To assign a notification profile to a basic event handler, see Creating a custom event handler on page 238.

To assign a notification profile to a correlation handler, see Creating a custom correlation handler on page 243.

To create a notification profile:

1. Goto Incidents & Events > Handlers > Notification Profiles.
2. Click Create New.
The Add New Notification Profile pane displays.

3. Configure the following options, and click OK to save the notification profile.

Option Description :

Name Enter a name for the naotification profile.
Send Alert through Fabric Send an alert through one or more fabric connectors selected from the
Connectors dropdown. Click the plus (+) to add fabric connectors. For more information,

see Fabric Connectors on page 173.

Send Alert Email Send an alert to one or more email addresses. Specify the email parameters,
including the mail server. For more information, see Mail Server on page 368.

To Enter the email address(es) to send the alert to. Use a semicolon (;) to
separate multiple email addresses.
From Enter a from address for the alert email.
Subject Enter a subject line for the alert email.
Email Server Select the mail server for the alert email.
Send SNMP(...) Trap Send an alert to an SNMP community or user selected from the dropdown. For

more information, see SNMP on page 321.

Send Alert to Syslog Server Send an alert to the syslog server selected from the dropdown. For more
information, see Syslog Server on page 369.

Send Each Alert Separately Enable to send each alert individually instead of in a group.

Creating a custom event handler

You can create a custom event handler from scratch or clone a predefined event handler and customize its settings. See
Cloning event handlers on page 251.

FortiAnalyzer 7.4.3 Administration Guide
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SD- The SD-WAN performance status comparison with interfaces. Mousing over the scatter

WAN Performance chart displays the status for health checks and member interface in a tooltip. The colors (red,

Status orange, yellow, and green) indicate the different percentage of a member's interface or
health check. Click on a scatter chart to view additional details.

SD-WAN Rules The SD-WAN rule traffic utilization by interface and application.
Utilization

SD-WAN Utilization The share of bandwidth utilization by application for each WAN link.
by Application

Top SD-WAN The top SD-WAN SLA issues.

SLA Issues The Sort By: Speed option in this widget requires event logs generated by speed tests from
FortiOS 7.4.0 or higher.

SD-WAN Events This widget displays a table chart for SD-WAN event logs which have a level higher than
notice (warning, error, etc.) within the selected time period.

Application The total bandwidth from all applications as well as the bandwidth per-SD-WAN interface.

Bandwidth This widget can be viewed in a sanky chart or table chart format.

Utilization

Per-Application The performance for the selected application based on chosen metric. You can select an

Performance application in the widget's Application dropdown menu.

Latency, Jitter, Packet Loss, and Bandwidth metrics are available.

Global-Application The global application performance for the selected metric.
Performance Latency, Jitter, and Packet Loss metrics are available.

SD-WAN Interfaces The information for SD-WAN interfaces and ADVPN shortcut interfaces.
Latency, Jitter, and Packet Loss metrics are available.
Audio MOS Score The MOS score by interface. Mousing over the chart displays a summary of the MOS score
and VolP quality at that point.
The interface must have a performance SLA with MOS enabled to display in the chart.
Speed Test The upload and download speeds for all tests run on SD-WAN interfaces through a specified
time.
This widget requires event logs generated by speed tests from FortiOS 7.4.0 or higher.

Health Check Status  This widget dynamically creates a child-widget for each health check where a line chart of

1-10 latency, jitter, and packet loss in the selected time period for SD-WAN interfaces is
displayed.
ﬂ To update the Refresh Interval, click the settings icon at the top of the widget, and then select a
value from the dropdown.

To filter a chart, click a key in the legend.

SD-WAN Summary

SD-WAN Summary monitor includes the following widgets:

FortiAnalyzer 7.4.3 Administration Guide
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Security Operations (SOC)

3. Inthe table chart, you can apply the following filters: Interface, IP, and Remote Gateway.

o \ SD-WAN Interfaces

4 OL_MPLS 0.0 17220126 17220127
i #oort2
4 port3 K 26.6 Kops
. @ oport o 0 Kops

 ports

SD-WAN chart for MOS scoring 1-11

An Audio MOS Score widget is added to FortiView > Monitors > Secure SD-WAN Monitor and FortiView > Monitors >
SD-WAN Summary. These widgets display logs for the MOS (mean opinion score) of voice and video traffic.

MOS is a method to measure the impact network quality has on the quality of a voice call. It is the industry standard for
measuring voice and video quality on a WAN link.

\‘é', The FortiGate version must be on version 7.2 or later and have the MOS codec and

MOS threshold attributes defined for SD-wan health check in order for FortiAnalyzer to display
information in the MOS scoring widgets.

To view the Audio MOS Score for individual devices:

1. Goto FortiView > Monitors > Secure SD-WAN Monitor.
2. Click Add Widget, and add the Audio MOS Score widget.

The widget includes a line graph of the MOS score for different codecs for the selected device over a specified time
period.

FortiAnalyzer 7.2.0 New Features Guide
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FortiAnalyzer Key Concepts

Most administrators may need to store between 30 and 60 days in Analytics, however, this should be configured for the
amount of time that you would typically need to explore the logs for.

If you need to run analytics for dates outside your Analytics retention, you may perform a database rebuild and load the
particular date range. A database rebuild involves purging all logs from Analytics and loading logs for the days of interest

from Archive. Once analysis is complete, you can then rebuild once more to load the most current logs into analytics
from the archive.

Data policy and automatic deletion

Use a data policy to control how long to keep compressed and indexed logs. When ADOMSs are enabled, you can specify

settings for each ADOM and the settings apply to all devices in that ADOM. When ADOMs are disabled, settings apply to
all managed devices.

A data policy specifies:

» How long to keep Analytics logs indexed in the database

When the specified length of time in the data policy expires, logs are automatically purged from the database but
remain compressed in a log file on the FortiAnalyzer disks.

« How long to keep Archive logs on the FortiAnalyzer disks
When the specified length of time in the data policy expires, Archive logs are deleted from the FortiAnalyzer disks.

See also Log storage information on page 151.

Disk utilization for Archive and Analytic logs

FortiView dashboard _

FortiAnalyzer 7.4.3 Administration Guide -

You can specify how much of the total available FortiAnalyzer disk space to use for log storage. You can specify what
ratio of the allotted storage space to use for logs that are indexed in the SQL database and for logs that are stored in a

compressed format on the FortiAnalyzer disks. Then you can monitor how quickly device logs are filling up the allotted
disk space.

Analytic logs indexed in the SQL database require more disk space than Archive logs (purged
\6, from the SQL database but remain compressed on the FortiAnalyzer disks).

An average Analytic log is 600 bytes, and an average Archive log is 80 bytes. By default, after
seven days Analytic logs are compressed and are an average of 150 bytes.

Keep this difference in mind when specifying the storage ratio for Analytics and Archive logs.

When ADOMs are enabled, you can specify settings for each ADOM and the settings apply to all devices in that ADOM.
When ADOMs are disabled, settings apply to all managed devices. See Log storage information on page 151.

[ 1-12
|
FortiAnalyzer provides dashboards for Security Operations Center (SOC) administrators. FortiView includes monitors

which enhance visualization for real-time activities and historical trends for analysts to effectively monitor network
activities and security alerts. See FortiView on page 85.
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System Settings

Deleting a CRL

To delete a CRL or CRLs:

Go to System Settings > Certificates.

Select the CRL or CRLs you need to delete.

Click Delete in the toolbar, or right-click and select Delete.

Click OK in the confirmation dialog box to delete the selected CRL or CRLs.

oM

Log Forwarding

1-13

You can forward logs from a FortiAnalyzer unit to another FortiAnalyzer unit, a syslog server, ora Common Event
Format (CEF) server when you use the default forwarding mode in log forwarding. You can also forward logs via an
output plugin, connecting to a public cloud service.

The client is the FortiAnalyzer unit that forwards logs to another device. The serveris the FortiAnalyzer unit, syslog
server, or CEF server that receives the logs.

In addition to forwarding logs to another unit or server, the client retains a local copy of the logs. The local copy of the
logs is subject to the data policy settings for archived logs. See Log storage on page 40 for more information.

involved, go to System Settings > Logging Topology. For more information, see Logging

; ﬂ To see a graphical view of the log forwarding configuration, and to see details of the devices
Topology on page 314.

Modes

FortiAnalyzer supports two log forwarding modes: forwarding (default), and aggregation.

Forwarding

Logs are forwarded in real-time or near real-time as they are received. Forwarded content files include: DLP files,
antivirus quarantine files, and IPS packet captures.

This mode can be configured in both the GUl and CLI.

Aggregation
As FortiAnalyzer receives logs from devices, it stores them, and then forwards the collected logs at a specified time
every day. To avoid duplication, the client only sends logs that are not already on the server.

FortiAnalyzer supports log forwarding in aggregation mode only between two FortiAnalyzer units. Syslog and CEF
servers are not supported.

FortiAnalyzer 7.4.3 Administration Guide
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System Settings

To add more hard disks:

1. Obtain the same disks as those supplied by Fortinet.
2. Back up the log data on the FortiAnalyzer unit.

You can also migrate the data to another FortiAnalyzer unit, if you have one. Data migration reduces system down
time and the risk of data loss.

3. Install the disks in the FortiAnalyzer unit.

If your unit supports hot swapping, you can do so while the unit is running. Otherwise the unit must be shut down
first. See Unit Operation widget on page 63 for information.

4. Configure the RAID level. See Configuring the RAID level on page 332.
5. Ifyou backed up the log data, restore it.

Administrative Domains (ADOMs)

1-14

Administrative domains (ADOMs) enable administrators to manage only those devices that they are specifically
assigned, based on the ADOMSs to which they have access. When the ADOM mode is advanced, FortiGate devices with
multiple VDOM s can be divided among multiple ADOMs.

Administrator accounts can be tied to one or more ADOMSs, or denied access to specific ADOMs. When a particular
administrator logs in, they see only those devices or VDOMs that have been enabled for their account. Super user
administrator accounts, such as the admin account, can see and maintain all ADOMs and the devices within them.

Each ADOM specifies how long to store and how much disk space to use for its logs. You can monitor disk utilization for
each ADOM and adjust storage settings for logs as needed.

The maximum number of ADOMs you can add depends on the FortiAnalyzer system model. Please refer to the
FortiAnalyzer data sheet for more information.

When the maximum number of ADOMs has been reached, you will be unable to create a new ADOM.

When upgrading to FortiAnalyzer 6.2.1 or later, you will continue to have access to any ADOMs exceeding the limit,
however, no additional ADOMs can be created, and an alert will be issued in the Alert Message Console in System
Settings > Dashboard.

By default, ADOMs are disabled. Enabling and configuring ADOMSs can only be done by administrators with the Super_
User profile. See Administrators on page 384.

The root ADOM and Security Fabric ADOMs are available for visibility into all Fabric devices. See Security Fabric
ADOMs on page 195.

(Y Y

S g @ Non-FortiGate devices are automatically located in specific ADOMs for their device type. They
9 cannot be moved to other ADOMs, except for FortiClient devices, which can be promoted to
= Fabric ADOMs if needed.

\\ . 'l
9 ADOMs must be enabled to support the logging and reporting of non-FortiGate devices.
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To check the I0C package in the CLI:
diagnose fmupdate fds—-getobject

FAZ object version information

ObjectId Description Version Size Created Date Time

00001000TIDB00100O ThreatIntel DB 00000.01052 34 MB 19/04/14 20:10
ext desc:ThreatIntel DB

00001000TIDB0O0100O ThreatIntel DB 00000.01053 37 MB 19/04/16 04:13

<latest> ext desc:ThreatIntel DB

FortiAnalyzer periodically syncs its own |OC TIDB files to the version of IOC package downloaded by fmupdate. This is
performed on a one hour schedule.

To check the license and TIDB version used by FortiAnalyzer in the CLI:
diagnose test application sgllogd 204 stats

License of post breach detection installed.
License expiration : 2025-Jan-04

TIDB version : 00000.01017-1902242107

TIDB load time : 2019-02-24 14:11:2

[©]]

Configuring FortiGate to FortiAnalyzer REST API authentication

FortiGate to FortiAnalyzer REST API authentication allows the FortiAnalyzer to send IOC alerts and trigger configured
automation rules, if configured.

To configure REST API authentication:

1. Goto the Device Managerin the FortiAnalyzer.
2. Edit the FortiGate device to set the FortiGate super admin username and password.
This is the only way to configure REST APl authentication prior to 6.2.

Alternatively, when configuring logging to FortiAnalyzer on FortiGate, you can go to Security Fabric > Settings and
enable Allow access to FortiGate REST APl and Trust FortiAnalyzer by serial number.

Throttling [OC alerts

To avoid flooding FortiGate with event alerts, you can configure a throttle which allows only one alert to be sent within a
set period of time for the same endpoint.
The default time period is one day (1440 minutes).

To set an IOC alert throttle in the CLI:

config system log ioc

(ioc) # set

notification Disable/Enable Ioc notification.

notification-throttle Minute value for throttling the rate of IoC notifications.

FortiAnalyzer 7.4.3 Administration Guide
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Highlights

Centralized network
monitoring and visibility

Advanced threat and
vulnerability detection
with event and log data
correlation

Augmented NOC/SOC
operations for real-time
response, analytics, and
reporting

Automation to save
time, reduce errors, and
improve efficiency

Multi-tenancy solution
with quota management

Administrative domains
for operational 1
effectiveness and
compliance

70+ reports and 2000+
ready-to-use datasets,
charts, and macros

-5

Data Sheet

U = _
A
(A

Analytics, Reports, and Compliance Across the Security Fabric

FortiAnalyzer is a powerful log management, analytics, and reporting
platform that provides organizations with a single console to manage,
automate, orchestrate, and respond, enabling simplified security
operations, proactive identification and remediation of risks, and

complete visibility of the entire attack landscape.

Integrated with the Fortinet Security Fabric, FortiAnalyzer enables

Network and Security Operations Teams with real-time detection

capabilities, centralized security analytics and end-to-end security

posture awareness to help analysts identify advanced persistent

threats (APTs) and mitigate risks before a breach can occur.
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FortiAnalyzer ™ - Secu iy Fab Data Sheet

Specifications

FORTIANALYZER APPLIANCES FAZ-150G FAZ-3006 FAZ-800G

Capacity and Performance

GBf day of Logs 25 100 200 200
Analxtic Sustained Rate (logs/ 500 2000 2000

sec)

g:(l:l)ictor Sustained Rate (logs/ 750 3000 5000

Devices/VDOMs (Maximum) 50 180 800

Max Number of Days Analytics** 90 50 50 50
Options

FortiGuard I0OC and Outbreak

Detection Service @ @ @ @
Security Automation Service @ @ @ @
Enterprise Bundle @ @ @ @
Hardware Bundle @ @ @ @
OT Security Service @ @ @ @
Security Rating and Compliance &

Service @ @ O @
Hardware Specifications

Form Factor (supports EIA/non- Desktop 1 RU Rackmount 7 RU Rackmount 1 RU Rackmount

EIA standards)

Total Interfaces 2 x RJ45 GE 4 x RJ45 GE 4 x RJ45 GE, 2 x SFP 4x RJ-45 2x GE SFPI

478 (2x 2T8) 8TB(2x478) 16 TB (4 x 4 TB) 1 —4| 1678 (4x 4TB) 3.5 in SAS HDDs |
Usable Storage (After RAID) 278 47B 8T8 8TB
Removable Hard Drives No No @ @

on RAD O RAID 1155510 [raoonssssne] 1 =4
RAID Type Software Software Hardware / Hot Swappabie Hardware / Hot Swappable
Default RAID Level 1 1 10 10
gﬁg::i‘ed:nt Hot Swap Power No Optional Optional Optional
Trusted Platform Module (TPM) *** Gen 2 Gen 2 @ @
Dimensions
Height x Width x Length (inches) 95x3.5x%x8 173 x 17.24 x 16.38 1.73 x 17.32 x 21.65 173 x 17.32 x 21.65
Height x Width x Length (cm) 241 % 89 x 20.55 44 x438x416 4.4 x 44.0 x 55.0 4.4 x 440 x 55.0
Weight 9.35 Ibs (4.24 kq) 22.5 Ibs {10.2 kg) 25.75 ibs (11.68 kg) 25.75 Ibs (11.68 kg)
Environment
AC Power Supply 100-240V AC, 50-60 Hz 100-240V AC, 60-50 Hz 100-240V AC, 50-60 Hz 100-240Vac, 50~60Hz, 4A max
Power Consumption (Average / 36W /43 W 90.1W /99 W 134 W /174.2 W 115W / 150W
Maximum)
Heat Dissipation 147.4 BTU/h 337.8 BTU/h 594.4 BTU/h 433 BTU/h
Operating Temperature 32°-104° F (0°-40°C) 32°-104° F (0°-40° C) 32°-104° F (0°-40° C) 32°-104° F (0°-40° C)
Storage Temperature -4°-167° F (-20°-75° C) -13°-167° F (-25°-75° C) -4°-167° F (-20°-75° C) -4°-167° F (-20°-75° C)
Humidity 5% to 95% non-condensing 20% to 80% non-condensing 5% to 95% non-condensing 5% to 95% non-condensing
Forced Airflow Front to Back Front to Back Front to Back Front to Back
Operating Altitude Up to 7400 ft (2250 m) Up to 7400 ft (2250 m) Up to 7400 ft (2250 m) Up to 7400 ft (2250 m)
Compliance
Safety Certifications FCC Part/\’l._S lClass A, RCM, VCCI, FCC Part 15 Class A, RCM, VCCI, FCC Part15 Qlass A, RCM, VCCI, FCC Part 15 Class A, RCM, VCCI,

CE, UL/cUL, CB CE, BSMI, KC, UL/cUL, CB, GOST CE, UL/cUL, CB CE, UL/cUL, CB

* Sustained Rate - maximum constant log message rate that the FAZ platform can maintain for minimum 48 hours without SQL database and system performance degradation
** The maximum number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate is lower.

*** Gen2 refers to hardware that has been upgraded since initial release.
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Capabilities

)

FortiGuard
Threat
Intelligence

soC
as a Service

FortiAnalyzer
HA Cluster

B

Headquaters
Data Center

FortiGate [ﬂ
{physical or FortiManager
virtual)
*
Logs
Internet
3
Logs Logs

FortiGate

FortiAnalyzer (physical or

Collector virtual)

< FortiGate
FortiAnalyzer {physical of

Collector virtual)

E Branch office

FartiAnalyzer * - Secun!y Faon Data Sheet

Deployments 1 _1

Deploying FortiAnalyzer

FortiAnalyzer can be deployed as a physical hardware appliance, virtual machine (VM) and
virtual machine subscription (VM-S), as well as private or public cloud instance, with scalability,
redundancy and backup, and high availability capabilities.

FortiAnalyzer High Availability (HA)

FortiAnalyzer HA provides real-time redundancy to protect organizations by ensuring
continuous operational availability. In the event that the primary (active) FortiAnalyzer fails,
a secondary (passive) FortiAnalyzer (up to four-node cluster) will immediately take over,
providing log and data reliability and eliminating the risk of having a single point of failure.

Multi-Tenancy with Flexible Quota Management

FortiAnalyzer provides the ability to manage multiple sub-accounts with each account
having its own administrators and users. The time-based archive/analytic log data policy, per
Administrative Domain (ADOM), allows automated quota management based on the defined
policy, with trending graphs to guide policy configuration and usage monitoring.

Analyzer Collector Modes

FortiAnalyzer provides two operation modes: Analyzer and Collector. In Collector mode, the
primary task is forwarding logs of the connected devices to an Analyzer and archiving the logs.
This configuration greatly benefits organizations with increasing log rates, as the resource
intensive log-receiving task is off-loaded to the Collector so that the Analyzer can focus on
generating analytics and reports.

Network operations teams can deploy multiple FortiAnalyzers in Collector and Analyzer modes
to work together to improve the overall performance of log receiving and processing increased
log volumes, providing log storage and redundancy, and rapid delivery of critical network and
threat information.

FortiAnalyzer Fabric

FortiAnalyzer Fabric allows SOC Administrators to configure two operation modes - Supervisor
and Member. This allows viewing of member devices, ADOMs and authorized logging devices,
as well as incidents and events created on members. Admins get access to Reports and
FortiView across all member FortiAnalyzers, and can perform global search in Log View of logs
collected across FortiAnalyzer Fabric members with pre-defined gevics 4 log drill
down for each Member and Member ADOMs and support for . B ' e
#i

A
§ o e L
B s .,
f

i

Log Forwarding for Third-Party Integration _ e 11
Forward logs from one FortiAnalyzer to another FortiAnalyzer unit, 3 Sysiog S&rver, or (CEF)
server. In addition to forwarding logs to another unit or server, the client FortiAnalyzer retains a
local copy of the logs, which are subject to the data policy settings for archived logs. Logs are

forwarded in real-time or near real-time as they are received from network devices.

11 3R NG B sSAC sREa 3= RSB BT (4




Appendix B - Log Integrity and Secure Log Transfer

SHA256

fips enabled TLS_AES_256_GCM_SHA384:TLS_CHACHA20_POLY1305_SHA256:TLS_AES_
128_GCM_SHA256:AES256-SHA:AES256-SHA256: DHE-RSA-AES256-
SHA:DHE-RSA-AES256-SHA256:ECDHE-RSA-AES256-SHA:ECDHE-RSA-
AES256-GCM-SHA384:ECDHE-ECDSA-AES256-SHA:ECDHE-ECDSA-AES256-
GCM-SHA384:AES128-SHA:AES128-SHA256:DHE-RSA-AES 128-SHA:DHE-
RSA-AES128-SHA256:ECDHE-RSA-AES128-SHA:ECDHE-RSA-AES128-GCM-
SHA256:ECDHE-ECDSA-AES128-SHA:ECDHE-ECDSA-AES128-GCM-SHA256

The following ciphers are not available when using forward secrecy (ssl-static-key-ciphers is disabled).

ssl-static-key-ciphers disabled
enc-algorithm

Low AES256-GCM-SHA384:AES256-CCM:ARIA256-GCM-SHA384:AES256-
SHA256:CAMELLIA256-SHA256:AES256-SHA:CAMELLIA256-SHA:AES128-
GCM-SHA256:AES128-CCM:AES 128-SHA256:CAMELLIA128-SHA256: AES128-
SHA:CAMELLIA128-SHA:AES256-CCM8:AES128-CCM8

Medium AES256-GCM-SHA384:AES256-CCM:ARIA256-GCM-SHA384:AES256-
SHA256:CAMELLIA256-SHA256: AES256-SHA:CAMELLIA256-SHA:AES128-
GCM-SHA256:AES128-CCM:AES128-SHA256: CAMELLIA128-SHA256:AES128-
SHA:CAMELLIA128-SHA:AES256-CCM8:AES128-CCM8

High AES256-GCM-SHA384:AES256-CCM:ARIA256-GCM-SHA384:AES256-
SHA256:CAMELLIA256-SHA256: AES256-SHA: CAMELLIA256-SHA:AES 128-
GCM-SHA256:AES128-CCM:AES128-SHA256:CAMELLIA128-SHA256:AES 128-
SHA:CAMELLIA128-SHA

fips enabled AES256-SHA:AES256-SHA256:AES128-SHA: AES128-SHA256

1-6

Maximum TLS/SSL version compatibility

The tables below indicate the maximum supported TLS version that you can configure for communication between a
FortiGate and FortiAnalyzer, as well as FortiAnalyzer's configured with log forwarding when the type is FortiAnalyzer.

For more information on secure log transfer and log integrity settings between FortiGate and FortiAnalyzer, see
Appendix B - Log Integnty and Secure Log Transfer on page 471.

Maximum configurable TLS version for FortiGate to FortiAnalyzer communication:

FAZ 6.4.0+ FAZ 6.2.0+ FAZ 6.0.0+
FGT 6.4.0+ tisv1.3 tlsv1.2 tisv1.2

FGT 6.2.3-6.2.8 tlsv1.3 tisv1.2 tisv1.2

FortiAnalyzer 7.6.1 Administration Guide
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Reports

How auto-cache works

When you generate a report, it can take days to assemble the required dataset and produce the report, depending on the
required datasets. Instead of assembling datasets at the time of report generation, you can enable the autfo-cache
feature for the report. Auto-cache is a setting that tells the system to automatically generate hcache.

hcache is a proprietary FortiAnalyzer caching system that stays on the disk in the form of a database table. Unlike other
caches, hcache tables are persistent and are not removed based on a set period of time.

When a database table is rolled, it becomes "mature”, meaning the table will not grow any more. Because the tables will
not grow, itis unnecessary to query the database table each time for the same SQL query. hcache runs queries on these
matured database tables in advance and caches the interim results of each query. When it is time to generate the report,
much of the datasets are already assembled, and the system only needs to merge the results from hcaches. This
reduces report generation time significantly.

The auto-cache process uses system resources to assemble and cache the datasets and it takes extra space to save
the query results. You should only enable auto-cache for reports that require a long time to assemble datasets.

1-7

Generating reports

You can generate reports by using one of the predefined reports or by using a custom report that you created. You can
find all the predefined reports and custom reports listed in Reports > Report Definitions > All Reports.

Click the icon in the Config Recommendation column to determine if the appropriate Analytics
logs are available for the report. For more information, see Report guidance on page 300.

To generate a report:

1. Goto Reports > Report Definitions > All Reports.
2. Inthe content pane, select a report from the list.

3. (Optional) Click Editin the toolbar and edit settings on the Settings and Layout tabs. For a description of the fields in
the Seftings and Layout tabs, see Reports Settings tab on page 306 and Creating charts on page 324 and Macro
library on page 327.

4. Inthe toolbar, click Run Report.

Generated reports can be attached to incidents. See Adding reports to an incident on page 136.

Report guidance

You can use the Report Guidance feature to determine if FortiAnalyzer has the appropriate Analytics logs available for a
report.

If Analytics logs are not available for a chart or macro used in the report, it will display No Data in the report output. For
example, the Analytics logs may not be available if;

= logging is not enabled correctly on the device,
 thelogrequires a FortiGuard license and you do not have one,

FortiAnalyzer 7.6.1 Administration Guide
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Incidents & Events

Viewing imported event handiers and reports

1 7 With a valid license, the FortiAnalyzer Outbreak Detection Service automatically downloads event handlers and reports
7 |created by Fortinet in response to known outbreaks. Handlers and reports are downloaded from FortiGuard as part of
the FOAS package. This section includes information on how to view downloaded outbreak event handlers and reports.

To view outbreak event handlers and reports:

1. Toview the event handlers, go to /ncidents & Events > Handlers > Basic Handlers.

Event handlers created by the FortiAnalyzer Outbreak Detection Service are displayed with the Outbreak Alert
prefix. See Event handlers on page 197.

Event Montor

Handiers
Incidents
Threat Hurting O € Ouibreas Aurt- Frosope Rancomware Soent Hacd
Leg Parser
Outoreak Alerts
- I > g @ rutbreae Alort TEK DR Attace Biont b
0 SetemSetag >
Fi3RTINET 0% 147

In FortiAnalyzer 7.6.0 and later, these event handlers will also have the Automatically Create Incident option
enabled. The incidents generated by these event handlers can be found in /ncidents & Events > Incidents >
Incidents.
2. |Toview the reports, go to Reports > Report Definitions > All Reports.
1 _7 o The Outbreak Alert Reports folder includes available reports from the FortiAnalyzer Outbreak Detection
Service. Reports can be run in HTML, PDF, XML, CSV, and JSON output formats. See Generating reports on
page 300.
o In FortiAnalyzer 7.4.2 and later, new reports included in the FOAS package are displayed in the global
Outbreak Alert Reports folder. Outbreak Alert reports released prior to this release remain at the ADOM level.
The global folder and global reports are identified with the system theme's color applied to the icon.

FortiAnalyzer 7.6.1 Administration Guide
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Log View and Log Quota Management

You can view log information by device or by log group.
When rebuilding the SQL database, Log View is not available until the rebuild is complete.
Click the Show Progress link in the message to view the status of the SQL rebuild.

When ADOMs are enabled, each ADOM has its own information displayed in Log View.

’] 8 Log View > Logs > All/ Fortinet Logs can display the real-time log or historical (Analytics) logs.

Log View > Logs > Log Browse can display logs from both the current, active log file and any compressed log files.

For more information, see Analytics and Archive logs on page 42.

Types of logs collected for each device

FortiAnalyzer can collect logs from the following device types: FortiADC, FortiAnalyzer, FortiAuthenticator, FortiCache,
FortiCarrier, FortiCASB, FortiClient, FortiDDoS, FortiDeceptor, FortiEDR,FortiIsoIator, FortiMail,
FortiManager, FortiNAC, FortiNDR, FortiPAM, FortiProxy, FortiSandbox, FortiSOAR, FortiWeb, and Syslog servers.
Following is a description of the types of logs FortiAnalyzer collects from each type of device:

Fabric Normalized
FortiADC Event, Intrusion Prevention, Traffic
FortiAnalyzer [ Event, Application | | —&3

FortiAuthenticator Event

FortiGate Traffic

Security: Antivirus, Intrusion Prevention, Application Control, Web Filter, File Filter, DNS,
Data Loss Prevention, Email Filter, Web Application Firewall, Vulnerability Scan, VoIP,
FortiClient

Event: Endpoint, HA, Compliance, System, Router, VPN, User, WAN Opt. & Cache, WiFi

%, : L File Filter logs are sent when the File Filter sensor is enabled in the
q FortiOS Web Filter profile. You can enable the File Filter sensor in
= FortiOS at Security Profiles > Web Filters.
FortiCache Traffic, Event, Antivirus, Web Filter
FortiCarrier Traffic, Event, GTP

FortiAnalyzer 7.6.1 Administration Guide
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| View | Description

Displays the highest network traffic by source IP address and interface,
device, threat score (blocked and allowed), sessions (blocked and

Top Sources allowed), and bytes (sent and received).

Displays the top source addresses by source object, interface, device,
—8 threat score (blocked and allowed), sessions (blocked and allowed), and
bytes (sent and received).

Top Source
Addresses

Displays the highest network traffic by destination IP addresses, the
applications used to access the destination, sessions, and bytes. If

Tap Destingtions available, click the icon beside the IP address to see its WHOIS

Traffic information.
o Displays the top destination addresses by destination objects,
Top Destination L . ) . . )
Addressss applications, sessions, and bytes. If available, click the icon beside the IP
address to see its WHOIS information.
) Displays the highest network traffic by country in terms of traffic sessions,
TopGauntiyRegion including the destination, threat score, sessions, and bytes.
. ' Lists the policy sessions by policy, device name, VDOM, number of hits,
Policy Hits .
bytes, and last used time and date.
DNS Lods Summarizes the DNS activity on the network. Double click an entry to drill
g down to the specific details about that domain.
ZTNA Servers ZTNA servers by bytes.
Displays the top cloud applications used on the network.
Top Cloud When viewing information about an application, FortiAnalyzer will first
Shadow IT Applications check the Shadow IT database, and if no results are found, it will use the
metadata.
Top Cloud Users Displays the top cloud users on the network.
Displays the top applications used on the network including the application
name, category, risk level, and sessions blocked and allowed. Bytes sent
Tob Abplicati and received can also be enabled through the widget settings. Top
1 —8 Gp#Appiicatons Applications can be viewed as a stackbar, bar, table, or bubble chart.
For a usage example, see Finding application and user information on
page 111.
Applications & -
Websites Top Website Displays the top allowed and blocked website domains on the network.
Domains
Top Website : . .
Categories Displays the top website categories.

Displays the top web-browsing users, including source, group, number of

Top Browsing Users sites visited, browsing time, and number of bytes sent and received.

FortiAnalyzer 7.6.1 Administration Guide
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FortiView dashboards for FortiGate and FortiCarrier devices

Category | Description

Lists the top threats to your network.
The following incidents are considered threats:
e Risk applications detected by application control.
 Intrusion incidents detected by IPS.
» Malicious web sites detected by web filtering.
» Malware/botnets detected by antivirus.

Displays a map of the world that shows the top traffic destinations starting
at the country of origin. Threats are displayed when the threat score is
greater than zero and either the source or destination IP is a public [P
address.

1-8

Top Threats

- Threat Map The Threat Window below the map, shows the threat, source, destination,
severity, and time. The color gradient of the lines indicate the traffic risk. A
yellow line indicates a high risk and a red line indicates a critical risk.
This view can be filtered by device, time, source, and destination. See also
Threats Viewing the threat map on page 94.

Displays end users with suspicious web use compromises, including end
users’ IP addresses, overall threat rating, and number of threats.
Indicator of To use this feature:
Compromise 1. UTM logs of the connected FortiGate devices must be enabled.
2. The FortiAnalyzer must subscribe to FortiGuard to keep its threat
database up-to-date.

Displays a summary of FortiSandbox related detections.

The following information is displayed: Filename, End User and/or IP,
Destination IP, Analysis (Clean, Suspicious or Malicious rating), Action
(Passthrough, Blocked, etc.), and Service (HTTP, FTP, SMTP, etc.).

Select an entry to view additional information in the drilldown menu.
Clicking a FortiSandbox action listed in the Process Flow displays details
about that action, including the Overview, Indicators, Behavior Chronology
Chart, Tree View, and more. Information included in the Details and Tree
View tab is only available with FortiSandbox 3.1.0 and above.

FortiSandbox
Detection

FortiAnalyzer 7.6.1 Administration Guide
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Dashboards

Alert Messages Console widget

The Alert Message Console widget displays log-based alert messages for both the FortiAnalyzer unit itself and

connected devices.
Alert messages help you track system events on your FortiAnalyzer unit such as firmware changes, and network events
such as detected attacks. Each message shows the date and time the event occurred.

VL
S @
9 Alert messages can also be delivered by email, syslog, or SNMP.

lit
S— < [

ox 10

Click Edit from the widget toolbar to view the Alert Message Console Settings, where you can adjust the number of
entries that are visible in the widget, and the refresh interval.

To view a complete list of alert messages, click Show More from the widget toolbar. The widget will show the complete
list of alerts. To clear the list, click Delete All Messages. Click Show Less to return to the previous view.

Log Receive Monitor widget

The Log Receive Monitor widget displays the rate at which the FortiAnalyzer unit receives logs over time. Log data can
be displayed by either log type or device.

Hover the cursor over a point on the graph to see the exact number of logs that were received at a specific time. Click the
name of a device or log type to add or remove it from the graph. Click Editin the widget toolbar to modify the widget's

settings.

FortiAnalyzer 7.6.1 Administration Guide
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Incidents & Events

Event Handler Description

140

Rule 7: Device phase2-up or phase2-down detected
¢ Event Severity: Medium
e Log Type: Event > VPN
e Log Field: Device Name, Message
* Log messages that match all of the following filters:

* Jogid=="0101037139" and (action=="phase2-up" OR action=="phase2-
down")

¢ Tags: NOC, VPN
* Custom message: ${logdesc} due to: ${action}

Default-NOC-SD-WAN-Events

Event handler for FortiGate device type logs to generate events for SD-WAN
status, alerts, and health check events including SLA targets/SLA met or not met
for jitter, latency. packetloss, Health-check server status (alive or dead), status
(up or down), and member status change.

FortiAnalyzer 7.6.1 Administration Guide
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Disabled by default
Rule 1: SLA failed for jitter
e Event Severity: High
e Log Type: Event > SD-WAN
e Log Field: Device Name, Health Check
* Log messages that match all of the following filters:
e subtype=="sdwan" AND metric=="jitter" AND msg~"SLA failed"
e Tags: NOC, SD-WAN
¢ Custom message: On ${devname} the SLA for the ${healthcheck} failed for
${metric} with the current value of ${jitter} which violates the target ID
${slatargetid}.
Rule 2: SLA failed for latency
* Event Severity: High
¢ Log Type: Event > SD-WAN
¢ Log Field: Device Name, Health Check
¢ Log messages that match all of the following filters:
e subtype=="sdwan" AND metric=="latency" AND msg~"SLA failed"
e Tags: NOC, SD-WAN
¢ Custom message: On ${devname} the SLA for the ${healthcheck} failed for
${metric} with the current value of ${latency} which violates the target ID
${slatargetid}.
Rule 3: SLA failed for packetloss
» Event Severity: High
* Log Type: Event > SD-WAN
Log Field: Device Name, Health Check
¢ Log messages that match all of the following filters:
e subtype=="sdwan" AND metric=="packetloss" AND msg~"SLA failed"
Tags: NOC, SD-WAN 1
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Mail Statistics

Outbreak Statistics
(FortiSandbox)

Statistics Summary

FortiProxy

Place your mouse over a bar in the graph to view a tooltip which includes the date/time,
classifier, and count.

This widget may be viewed by Count and Size.

This widget can be also be displayed as a donut chart which includes charts for total mail,
virus mail, and spam mail.

The summary of email messages where the FortiMail detected viruses, spam, or neither in the
selected time period.

Place your mouse over a bar in the graph to view a tooltip which includes the date/time,
classifier, and count.

This widget may be viewed by Count, Size, Scan Speed, and Transfer Speed.

The summary of the number of email messages that the FortiSandbox unit is scanning in the
selected time period. Email messages are tracked as either clean, containing a malicious file,
or containing a malicious URL.

Place your mouse over a bar in the graph to view a tooltip which includes the date/time, clean,
malicious file, and malicious URL.

This widget requires a FortiSandbox.
The summary of spam, viruses, and not spam in the selected time period, including the

classifier details per category, the corresponding total number of every classifier, the subtotal
number, the subtotal percentage of every category, and the total number of all emails.

FortiProxy includes the following widgets:

Top Proxy Sources

Top Proxy
Destinations

Top Website
Domains

Top Threats
Destinations

Top Threats
Top Applications
Top DLP Events

Top proxy sources by number of sessions.

Top proxy destinations by number of sessions.

Top website domains by number of sessions.

Top threat destinations by threat level.

Top threats by threat level.
Top applications by risk.

Top DLP events by number of incidents.

Secure SD-WAN Monitor 1 —1 1

Secure SD-WAN Monitor includes the following widgets:

SD-WAN Bandwidth
Overview

FortiAnalyzer 7.6.1 Administration Guide

Fortinet Inc.

The bandwidth of the SD-WAN network over time. This widget d
sent/received rate (bps) in the selected time period for SD-WA al

fieehart of the
interfaces.

i ; o'
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1-11

SD-
WAN Performance
Status

SD-WAN Rules
Utilization

SD-WAN Utilization
by Application

Top SD-WAN
SLA Issues

SD-WAN Events

Application
Bandwidth
Utilization

Per-Application
Performance

Global-Application
Performance

SD-WAN Interfaces

The SD-WAN performance status comparison with interfaces. Mousing over the scatter
chart displays the status for health checks and member interface in a tooltip. The colors (red,
orange, yellow, and green) indicate the different percentage of a member's interface or
health check. Click on a scatter chart to view additional details.

The SD-WAN rule traffic utilization by interface and application.

The share of bandwidth utilization by application for each WAN link.

The top SD-WAN SLA issues.
The Sort By: Speed option in this widget requires event logs generated by speed tests from
FortiOS 7.4.0 or higher.

This widget displays a table chart for SD-WAN event logs which have a level higher than
notice (warning, error, etc.) within the selected time period.

The total bandwidth from all applications as well as the bandwidth per-SD-WAN interface.
This widget can be viewed in a sanky chart or table chart format.

The performance for the selected application based on chosen metric. You can select an
application in the widget's Application dropdown menu.

Latency, Jitter, Packet Loss, and Bandwidth metrics are available.

The global application performance for the selected metric.
Latency, Jitter, and Packet Loss metrics are available.

The information for SD-WAN interfaces and ADVPN shortcut interfaces.
Latency, Jitter, and Packet Loss metrics are available.

Audio MOS Score

The MOS score by interface. Mousing over the chart displays a summary of the MOS score
and VolIP quality at that point.

The interface must have a performance SLA with MOS enabled to display in the chart.

Speed Test

Health Check Status

The upload and download speeds for all tests run on SD-WAN interfaces through a specified
time.

This widget requires event logs generated by speed tests from FortiOS 7.4.0 or higher.
This widget dynamically creates a child-widget for each health check where a line chart of

latency, jitter, and packet loss in the selected time period for SD-WAN interfaces is
displayed.

To update the Refresh Interval, click the settings icon at the top of the widget, and then select a
value from the dropdown.

To filter a chart, click a key in the legend.

R

SD-WAN Summary

SD-WAN Summary monitor includes the following widgets:

FortiAnalyzer 7.6.1 Administration Guide
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Dashboards

Widget Description

e Known or Suspected URL-based Attack
s Known or Suspected Impersonation-based Threats

Email Bandwidth An area chart that displays the amount of bandwidth used by email traffic, which
includes data for inbound emails and spam emails over time. Mouse over the
chart to display a tooltip of values for inbound and spam emails at that time.

Email Count A stacked bar chart that displays the number of emails over time by inbound
emails and spam emails. Mouse over the chart to display a tooltip of values for
inbound or spam emails at that sample time.

Top Senders by Email Size A pie chart that displays the email accounts which have sent the largest emails by
size. Mouse over the chart to display a tooltip of the email account and the amount
of emails sent by size and percentage.

Top Recipients by Email Size A pie chart that displays the email accounts which have received the largest
emails by size. Mouse over the chart to display a tooltip of the email account and
the amount of emails received by size and percentage.

Top Recipients by Count A race bar chart that displays the top email accounts with highest number of
emails received. The chart is animated to show the number of emails for each
account over time.

Top Senders by Count A race bar chart that displays the top email accounts with highest number of
emails sent. The chart is animated to show the number of emails for each account
over time.

Top Malware Senders Displays email accounts that have sent the highest number of malwares using
email.

Top Phishing Senders Displays email accounts with the highest number of attempts to send phishing
emails.

Top Spam Senders Displays spammer email accounts sorted by email count.

112

SOC dashboard

The SOC Dashboard provides an overview of incidents, events, and alerts. By clicking on widgets in the dashboard, you
can open the detailed information in the Incidents & Events pane, as well as other panes in the FortiAnalyzer GUI.

Use the time range dropdown to filter all widgets in the SOC Dashboard. You can customize which widgets appear in the
dashboard. After clicking Edit, select which widgets should appear using the Toggle Widget dropdown. You can also
resize and move widgets in this display. Once the changes are complete, click Save.

By default, the Statistics widget displays at the top of the dashboard. The following is available in the Statistics widgetin
the SOC Dashboard.

FortiAnalyzer 7.6.1 Administration Guide
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System Settings

Deleting a CRL

To delete a CRL or CRLs:

Go to System Settings > Certificates.

Select the CRL or CRLs you need to delete.

Click Delete in the toolbar, or right-click and select Delete.

Click OK in the confirmation dialog box to delete the selected CRL or CRLs.

1413
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Log Forwarding

You can forward logs from a FortiAnalyzer unit to another FortiAnalyzer unit, a syslog server, ora Common Event
Format (CEF) server when you use the defauit forwarding mode in log forwarding. You can also forward logs via an
output plugin, connecting to a public cloud service.

The clientis the FortiAnalyzer unit that forwards logs to another device. The serveris the FortiAnalyzer unit, syslog
server, or CEF server that receives the logs.

In addition to forwarding logs to another unit or server, the client retains a local copy of the logs. The local copy of the
logs is subject to the data policy settings for archived logs. See Log storage on page 40 for more information.

involved, go to System Settings > Logging Topology. For more information, see Logging

X To see a graphical view of the log forwarding configuration, and to see details of the devices
Topology on page 341.

Modes

FortiAnalyzer supports two log forwarding modes: forwarding (default), and aggregation.

Forwarding

Logs are forwarded in real-time or near real-time as they are received. Forwarded content files include: DLP files,
antivirus quarantine files, and IPS packet captures.

This mode can be configured in both the GUI and CLI.

Aggregation
As FortiAnalyzer receives logs from devices, it stores them, and then forwards the collected logs at a specified time
every day. To avoid duplication, the client only sends logs that are not already on the server.

FortiAnalyzer supports log forwarding in aggregation mode only between two FortiAnalyzer units. Syslog and CEF
servers are not supported.

FortiAnalyzer 7.6.1 Administration Guide
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System Settings

To add more hard disks:

1. Obtain the same disks as those supplied by Fortinet.

2. Back upthelogdata on the FortiAnalyzer unit.
You can also migrate the data to another FortiAnalyzer unit, if you have one. Data migration reduces system down
time and the risk of data loss.

3. Install the disks in the FortiAnalyzer unit.
If your unit supports hot swapping, you can do so while the unitis running. Otherwise the unit must be shut down
first. See Unit Operation widget on page 64 for information.

4. Configure the RAID level. See Configuring the RAID level on page 359.
5. Ifyou backed up the log data, restore it.

114

Administrative Domains (ADOMs)

Administrative domains (ADOMs) enable administrators to manage only those devices that they are specifically
assigned, based on the ADOMs to which they have access. When the ADOM mode is advanced, FortiGate devices with
multiple VDOMSs can be divided among multiple ADOMs.

Administrator accounts can be tied to one or more ADOMs. or denied access to specific ADOMs. When a particular
administrator logs in. they see only those devices or VDOMSs that have been enabled for their account. Super user
administrator accounts. such as the admin account. can see and maintain all ADOMs and the devices within them.

Each ADOM specifies how long to store and how much disk space to use for its logs. You can monitor disk utilization for
each ADOM and adjust storage settings for logs as needed.

The maximum number of ADOMs you can add depends on the FortiAnalyzer system model. Please refer to the
FortiAnalyzer data sheet for more information.

When the maximum number of ADOMs has been reached, you will be unable to create a new ADOM.

When upgrading to FortiAnalyzer 6.2.1 or later, you will continue to have access to any ADOMs exceeding the limit,
however, no additional ADOMs can be created, and an alert will be issued in the Alert Message Console in Dashboards
> Status.

By default, ADOMs are disabled. Enabling and configuring ADOMs can only be done by administrators with the Super_
User profile. See Administrators on page 411.

The root ADOM and Security Fabric ADOMs are available for visibility into all Fabric devices. See Security Fabric
ADOMs on page 176.

< ! & Non-FortiGate devices are automatically located in specific ADOMs for their device type. They
9 cannot be moved to other ADOMs, except for FortiClient devices, which can be promoted to
= Fabric ADOMs if needed.

\‘ : 'l
q ADOMs must be enabled to support the logging and reporting of non-FortiGate devices.
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To check the 10C package in the CLI:
diagnose fmupdate fds-getobject

FAZ object version information

ObjectId Description Version Size Created Date Time

00001000TIDR0O0100 ThreatIntel DB 00000.01052 34 MB 19/04/14 20:10
ext _desc:ThreatIntel DB

00001000TIDB0O0100O ThreatIntel DB 00000.01053 37 MB 19/04/16 04:13

<latest> ext_desc:ThreatIntel DB

FortiAnalyzer periodically syncs its own IOC TIDB files to the version of IOC package downloaded by fmupdate. This is
performed on a one hour schedule.

To check the license and TIDB version used by FortiAnalyzer in the CLI:
diagnose test application sgllogd 204 stats

License of post breach detection installed.
License expiration : 2025-Jan-04

TIDB version : 00000.01017-1902242107

TIDB load time : 2019-02-24 14:11:2 '] _1 5

Configuring FortiGate to FortiAnalyzer REST API authentication

FortiGate to FortiAnalyzer REST API authentication allows the FortiAnalyzer to send I0C alerts and trigger configured
automation rules, if configured.

To configure REST API authentication:

1. Goto the Device Managerin the FortiAnalyzer.

2. Editthe FortiGate device to set the FortiGate super admin username and password.
This is the only way to configure REST API authentication prior to 6.2.

Alternatively, when configuring logging to FortiAnalyzer on FortiGate, you can go to Security Fabric > Settings and
enable Allow access fo FortiGate REST APl and Trust FortiAnalyzer by serial number.

Throttling 10C alerts

To avoid flooding FortiGate with event alerts, you can configure a throttle which allows only one alert to be sent within a
set period of time for the same endpoint.
The default time period is one day (1440 minutes).

To set an IOC alert throttle in the CLI:

config system log ioc

(ioc)# set

notification Disable/Enable Ioc notification. | 4
notification-throttle Minute wvalue for throttling the rate ok ToC notific%tions.

FortiAnalyzer 7.6.1 Administration Guide
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Highlights

Centralized network
monitoring and visibility

® Advanced threat and
vulnerability detection

withieventznd b s Analytics, Reports, and Compliance Across the Security Fabric
correlation

= Augmented NOC/SOC FortiAnalyzer is a powerful log management, analytics, and reporting
operations for real-time ) . ) ) )
response, analytics, and platform that provides organizations with a single console to manage,
reporting

automate, orchestrate, and respond, enabling simplified security
B Automation to save

Hme, reducerenrs, snd operations, proactive identification and remediation of risks, and
improve efficiency

® Multi-tenancy solution complete visibility of the entire attack landscape.
with quota management

= Administrative domains Integrated with the Fortinet Security Fabric, FortiAnalyzer enables
for operational X . . . ;
effectiveness and Network and Security Operations Teams with real-time detection
compliance

capabilities, centralized security analytics and end-to-end security
® 70+ reports and 2000+

ready-to-use datasets, posture awareness to help analysts identify advanced persistent
charts, and macros

threats (APTs) and mitigate risks before a breach can occur.
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FortiAnalyzer™ - Sscuniy Favne Nabwerk Analy Les a0y Automaion Data Sheet

Capabilities

Incident Detection and Response

Centralized NOC/SOC Visibility for the Attack Surface

FortiAnalyzer provides Security Fabric Analytics across all device logs with event correlation
and real-time detection of Advanced Persistent Threats (APTs), vulnerabilities and Indicators
of Compromise (I0OC) for FortiGate NGFWs, FortiClient, FortiSandbox, FortiWeb, FortiMail and
other Fortinet products, for deep visibility and critical network insights. Simplified orchestration
and automated workflows provide Network Security Operations teams with real-time
notifications, reports, and dashboards for single-pane visibility and actionable results.

Incidents and Events Management

Security teams can monitor and manage alerts and event logs from Fortinet devices, with
events processed and correlated in a format that analysts can easily understand. Investigate
suspicious traffic patterns and search using filters in predefined or custom event handlers to
generate real-time notifications and monitoring for NOC and SOC operations, SD-WAN, SSL
VPN, wireless, Shadow IT, IPS, network recon, FortiClient, and more.

The Incidents component enables analysts to manage incident handling and life cycle, with
incidents generated by events that show affected assets, endpoints, users and timelines.

Fabric Automation

FortiAnalyzer Playbooks boost an organization’s security team abilities to simplify investigation
efforts through automated incident response, freeing up resources and allowing analysts to
focus on critical tasks. Out-of-the-box playbook templates enable SOC analysts to quickly
customize their use cases, define custom processes, interact with other Security Fabric
devices like FortiOS and EMS, edit playbooks and tasks in the visual playbook editor and use
the Playbook Monitor for investigation of compromised hosts, infections and critical incidents,
data enrichment for Assets and Identity views, blocking malware, C&C IPs, and more.

Security Fabric Analytics

Analytics and Reporting

FortiAnalyzer automation driven analytics empowers network security operations teams to
complete a fast assessment of network devices, systems, and users, with correlated log data
and FortiGuard threat intelligence for analysis of real-time and historical events.

FortiView Monitors and Views provide deep insights with context and meaning of network
activity, risks, vuinerabilities, attack attempts, indicators of compromise and anomalies,
sanctioned and unsanctioned user activity.

Log View enables analysts to expand their investigation and utilize search filters on
managed device logs, drill down on logs, with custom views and log groups, including a
SIEM database with normalized logs for Fortinet devices in Fabric ADOMs.

Reports provide comprehensive analysis of your Security Posture, including reports for
Operational Technology (OT), security rating, security rating for PCI, Secure SD-WAN, VPN,
FortiNDR network anomaly detection, cyber threat assessments, 360 Securlty Reviews,
situational awareness, compliance, auditing, and more.
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FortiAnalyzer " -

Capabilities

Assets and Identity

Data Sheet

FortiAnalyzer Fabric View with Assets and Identity monitoring provides SOC teams with
elevated awareness and visibility into an organization’s endpoints and users with dashboards
and correlated device and UEBA information, vulnerability detections, EMS tagging, and asset
classifications through telemetry with EMS, NAC, Fortinet Fabric Agent, and an OT Dashboard

View.

prive FortiAnalyzer
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Emotet Malware Resurgence

First wave of the year 2023

Emotet a Troan that 1s d:sinouted via spam amals. nas ceen srevaient since s firs 2arance In 2074 ¥ith a netivork mace up of mMulile

< v:a phishing attacks

Zotnets Emotet has continuousiy sent out spam emails (0 camoagns desigred to nfect u!

Background Tre EuroFol nas consdered Emotet 35 one 07 he w0rd's MOst Cangerous maivare It 3¢ first Ciscovared on
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Subscriptions and Extensions

Subscription Licenses and FortiGuard Security Services

= FortiGuard Outbreak Detection Service delivers automated content package download
for detecting the latest malware, including a summary of outbreaks and kill chain mapping
for how the malware works. The package includes a FortiGuard Report for the outbreak,
Event Handler, and a Report Template to detect outbreaks.

» FortiGuard Indicators of Compromise Service empowers security teams with forensic
data from 500 000 IOCs daily, used in combination with FortiAnalyzer analytics to identify
suspicious usage and artifacts observed on the network or in an operations system, that
have been determined with high confidence to be malicious infections or intrusions, and
historical rescan of logs for threat hunting.

» Shadow IT Monitoring Service provides continuous monitoring of unapproved devices,
resources, unsanctioned accounts and unauthorized use of SaaS and laaS, APl integration,
and third party apps. The service identifies rogue users using personal accounts for
managing company assets, using correlated FortiOS and FortiCASB data with a FortiCASB
account subscribed for SaaS features.

» OT Security Service provides security teams with advanced OT analytics, risk and
compliance reports, OT event handlers, and use-case correlation rules.

» Security Rating and Compliance Service helps security teams design, implement, and
maintain their security posture, and provides actionable configuration recommendations as
well as key performance and risk indicators.

»  Security Automation Service subscription enables further automation for incident
response with enhanced monitoring and escalation, built-in incident management
waorkflows, connectors, playbooks and more.

Management Extension Applications (MEAs)

The Management Extensions pane allows you to enable licensed applications that are
released and signed by Fortinet, which can be installed and run on FortiAnalyzer, including the
FortiSIEM and FortiSOAR.
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation Data Sheet

Deploying FortiAnalyzer

FortiAnalyzer can be deployed as a physical hardware appliance, virtual machine (VM) and
virtual machine subscription (VM-S), as well as private or public cloud instance, with scalability,
redundancy and backup, and high availability capabilities.

FortiAnalyzer High Availability (HA)

FortiAnalyzer HA provides real-time redundancy to protect organizations by ensuring
continuous operational availability. In the event that the primary (active) FortiAnalyzer fails,
a secondary (passive) FortiAnalyzer (up to four-node cluster) will immediately take over,
providing log and data reliability and eliminating the risk of having a single point of failure.

Multi-Tenancy with Flexible Quota Management

FortiAnalyzer provides the ability to manage multiple sub-accounts with each account
having its own administrators and users. The time-based archive/analytic log data policy, per
Administrative Domain (ADOM), allows automated quota management based on the defined
policy, with trending graphs to guide policy configuration and usage monitoring.

Analyzer Collector Modes

FortiAnalyzer provides two operation modes: Analyzer and Collector. In Collector mode, the
primary task is forwarding logs of the connected devices to an Analyzer and archiving the logs.
This configuration greatly benefits organizations with increasing log rates, as the resource
intensive log-receiving task is off-loaded to the Collector so that the Analyzer can focus on
generating analytics and reports.

Network operations teams can deploy multiple FortiAnalyzers in Collector and Analyzer modes
to work together to improve the overall performance of log receiving and processing increased
log volumes, providing log storage and redundancy, and rapid delivery of critical network and
threat information.

FortiAnalyzer Fabric

FortiAnalyzer Fabric allows SOC Administrators to configure two operation modes - Supervisor
and Member. This allows viewing of member devices, ADOMs and authorized logging devices,
as well as incidents and events created on members. Admins get access to Reports and
FortiView across all member FortiAnalyzers, and can perform global search in Log View of logs
collected across FortiAnalyzer Fabric members with pre-defined device filters and log drill

down for each Member and Member ADOMSs.

Log Forwarding for Third-Party Integration

Forward logs from one FortiAnalyzer to another FortiAnalyzer unit, a syslog server, or (CEF)

server. In addition to forwarding logs to another unit or server, the client FortiAnalyzer retains a
local copy of the logs, which are subject to the data policy settings for archived logs. Logs are
forwarded in real-time or near real-time as they are received from K i
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Cloud Services

FortiAnalyzer Cloud

FortiAnalyzer Cloud offers customers a PaaS-based delivery option for automation-driven, single pane analytics, providing
log management, analytics, and reporting for Fortinet NGFW and SD-WAN with an easily accessible cloud-based solution.
FortiAnalyzer Cloud delivers reliable real-time insights into network activity with extensive reporting and monitering for clear,
consistent visibility of an organization’s security posture. Customers can easily access their FortiAnalyzer Cloud from their
FortiCloud single sign-on portal.

Virtual Offerings

FortiAnalyzer VM Subscription

The FortiAnalyzer VM Subscription license model consolidates into one single SKU: VM product SKU, FortiCare Support SKU,
FortiGuard IOC and Outbreak Detection Service, Security Automation services, to simplify the product purchase, upgrade,

and renewal. FortiAnalyzer-VM S provides organizations with centralized security event analysis, forensic research, reporting,
content archiving, data mining, malicious file quarantining, and vulnerability assessment. Centralized collection, correlation, and
analysis of geographically and chronologically diverse security data from Fortinet and third party devices deliver a simplified,
consolidated view of your security posture.

The FortiAnalyzer-VM S series SKUs come in stackable 5, 50, and 500 GB/ day logs licenses, so that multiple units of this SKU
can be purchased together providing organizations with the ability and cost-efficiencies to scale and meet their logging needs.

FortiAnalyzer VM

Fortinet offers the FortiAnalyzer-VM licensing in a stackable perpetual license model with a-la-carte technical support and
subscription services.

This software-based version of the FortiAnalyzer hardware appliance is designed to run on many virtualization platforms, which
allows you to expand your virtual solution as your environment expands.

FORTIANALYZER VIRTUAL APPLIANCES FAZ-VM-GB25 FAZ-¥M-GB100 FAZ-VM~-GB500 FAZ-VM-GB2000
Capacity
GB/ day of Logs * +1 +5 +25 +100 +500 +2000
Devices/VDOMs Maximum 10 000 10 000 10 000 10 000 10 000 10 000
FortiGuard 10C Service ©
Security Automation Service @
Hypervisor Support Up-to-date hypervisor support can be found in the release note for each FortiAnalyzer version.
Visit https://docs.fortinet com/product/fortianalyzer/ and find the Release Information at the bottom section.

Go to “Product Integration and Support” - “FortiAnalyzer [version] support” - "Virtualization”
vCPU Support (Minimum / Maximum) 4 [ Unlimited
Network Interface Support (Min / Max) ™ 1/12
Memory Support (Minimum / Maximum) 16 GB / Unlimited for 64-bit

* Unlimited GB/ day when deployed In collector mode.
* /M supports up to 12 vNIC interfaces/ports. Applicable to 6.4.3+. Actual consumable numbers vary depending on cloud piatforms
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FortiAnalyzer™ - Security Fabric Network Analytics and Automation

Specifications

FORTIANALYZER APPLIANCES
Capacity and Performance
GB/ day of Logs

Analytic Sustained Rate (logs/
sec)*

Collector Sustained Rate (logs/
sec)*

Devices/VDOMs (Maximum)

Max Number of Days Analytics**

Options

FortiGuard IOC and Outbreak
Detection Service

Security Automation Service
Enterprise Bundle

Hardware Bundle

OT Security Service

Security Rating and Compliance
Service

Hardware Specifications

Form Factor (supports EIA/non-
EIA standards)

Total Interfaces

Storage Capacity

Usable Storage (After RAID)
Removable Hard Drives
RAID Levels Supported
RAID Type

Default RAID Level

Redundant Hot Swap Power
Supplies

Trusted Platform Module (TPM) ***
Dimensions

Height x Width x Length {inches)
Height x Width x Length {cm)
Weight

Environment
AC Power Supply

Power Consumption (Average /
Maximum)

Heat Dissipation
Operating Temperature
Storage Temperature
Humidity

Forced Airflow
Operating Altitude

Compliance

Safety Certifications

FAZ-1506

25

500

© OO E

Desktop

2x RJ45 GE
4TB (2% 27TB)

278
No
on

Software
1
No

Gen 2

95x%x35x%8
241 % 8.9 x 20.55
9.35 Ibs (4.24 kg)

100-240V AC, 50-60 Hz
3BW/43W

147.4 BTU/h
32°F to 104° F (0°C to 40° C)
-4°F t0 167° F (-20°C t0 75° C)
5% to 95% non-condensing

Front to Back

Up to 7400 ft (2250 m)

FCC Part 15 Class A, RCM, VCCI,
CE, UL/cUL, CB

© OO

1 RU Rackmount

4x RJA5 GE
8 TB (2x 4 TB)

47TB
No
RAID 01
Software
1
Optional

Gen 2

173 x17.24 x 16.38
44 %438 x 418
22.51bs {10.2 kg)

100-240V AC, 60-50 Hz
901 W /99w

337.8 BTU/h
32°F t0104° F (0°C to 40° C)
-13°F to 167° F (-25°C t0 75° C)
20% to 90% non-condensing

Front to Back

Up to 7400 ft (2250 m)

FCC Part 15 Class A, RCM, VCCI,
CE, BSMI, KC, UL/cUL, CB, GOST

{28 TT v B e 3

©
©
©
©
@
©

1 RU Rackmount

4x RJ-45 2x GE SFP
16TB (4x 4TB) 3.5 in SAS HDDs

878

&

RAID 0/11s/5,5s/10
Hardware / Hot Swappable

10

Optional

©

1.73 x 17.32 x 21.65
4.4 x 44.0 x 55.0
25.75 Ibs (11.68 kg)

100-240Vac, 50~60Hz, 4A max
M5W /150w

433 BTU/h
32°F to 104° F (0°C to 40° C)
-4°F t0 167° F (-20°C t0 75° C)
5% to 95% non-condensing

Front to Back

Up to 7400 ft (2250 m)

FCC Part 15 Class A, RCM, VCC|,

CE, UL/cUL, CB

Data Sheet

FAZ-1000G

660

20 000

30000

2000

© 0O E

2 RU Rackmount

2x 2.5GbE RJ45 + 2x 25GbE SFP28

32 TB (8 x ATB) 3.5 in SAS SED
HDD

24 TB
RAID 0/1/5/6/10/50/60
Hardware / Hot Swappable
50

©
©

3.46 x 17.24 x 24.41
8.8x43.8x620
496 Ibs (22.5 kg)

100-240Vac, 50~680Hz, 4A max
251.36W [ 302w

857.73 BTU/h
32°F t0 104° F (0°C to 40° C)
-40°F to 158° F (-40°C to 70° C)
% to 95% non-condensing

Front to Back

Up to 16 404 ft (5000 m)

FCC Part 15 Class A, RCM, VCCI,
CE, UL/eUL, CB

* Sustaired Rate - maximum constant log message rate that the FAZ platform can maintain for minimum 48 hours without SQL database and system performance degradation.

** The maximum number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate is lower.

*=x Gen?2 refers to hardware that has been upgraded since initial release.
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Specifications

FORTIANALYZER APPLIANCE
Capacity and Performance
GB/ day of Logs

Analytic Sustained Rate
(logs/sec)*

Collector Sustained Rate
(logs/sec)*

Devices/VDOMs (Maximum})
Max Number of Days Analytics**
Options

FortiGuard I0C and Outbreak Detection
Service

Security Automation Service

Enterprise Bundle

Hardware Bundle

OT Security Service

Security Rating and Compliance Service
Hardware Specifications

Form Factor (supports EIA/non-EIA
standards)

Total Interfaces

Storage Capacity

Usable Storage (After RAID)
Removable Hard Drives

RAID Levels Supported

RAID Type

Default RAID Level

Redundant Hot Swap Power Supplies
Trusted Platform Module (TPM) ***
Dimensions

Height x Width x Length (inches)
Height x Width x Length (cm)
Weight

Environment

AC Power Supply

Power Consumption (Average/Max)
Heat Dissipation

Operating Temperature

Storage Temperature

Humidity

Forced Airflow

Operating Altitude

Compiiance

Safety Certifications

FortiAnalyzer " - S=cu

©
©
©
@
©
&

3 RU Rackmount

2x GE RJ45, 2x 25GE SFP28

64 TB {16 x 4TB) 3.5" SAS SED HDD + 3.84

(2% 1.927T8B) 2.5" NVMe SSD
568 TB

©

RAID
0/1,1s/5,5s/6,65/10/50/60

Hardware / Hot Swappable
50
©)

52%17.2 x 255
13.0 x 44.0 x 65.0
69.6 ibs (31.57 kg)

100-127V~/10A, 200-240V~/5A
395 W /510 W
1740.19 BTU/h
32°F to 104°F (0°C to 40°C)
-4°F to 158°F (-20°C to 70°C)
5% to 85% (non-condensing)
Front to Back
Up to 13 123 ft (4000 m)

FCC Part 15 Class A, RCM, VCC!, CE, UL/

cUL,CB

FCC Part 15 Class A, RCM, VCCI, CE, UL/

Data Sheet

5000

80 000

90 000

10 000

OOOOO ©

4 RU Rackmount

2x 10GbE RJ45, 2x 25GDE SFP28
24x 4TB (96TB) + 2x 3.84TB (7.68TB)

84 TB

©

RAID
0/1,1s/5,5s/6,65/10/50/60

Hardware / Hot Swappable

OO &

7x17.2 % 275
17.8 x 43.7 x 69.9
65 Ibs (29.5 kg)

100-127V~/10A, 200-240V~/5A
983 W /1278 W
3424 BTU/h
32°F t0 104°F (0°C to 40°C)
-4°F to 167°F {-20°C to 75°C)
5% to 95% (non-condensing)
Front to Back
Up to 10 000 ft (3048 m)

cUL, CB

8300

100 000

150 000

10 000
60

OOOOO ©®©

4 RU Rackmount

2x 10GE RJ-45 + 2x 25GE SFP28

2407TB (60x 4TB} 3.5 n HDD + 19.2TB
(6% 3.2TB) NVMe SSD

224 7B

©

RAID
0/11s/5,5s/6,88/10/50/60

Hardware / Hot Swappabie

O3

7.0 x17.2 x 30.2
17.8 x 43.7 x 76.7
118 Ibs (53.5 kg)

2000W ACH***
850 W /1423.4 W
4858 BTU/h
50°F to 95°F (10°C to 35°C)
-40°F to 158°F (-40°C to 70°C)
8% to 90% (non-condensing)
Front to Back
Up to 7400 ft (2250 m)

FCC Part 15 Class A, RCM, VCCI, CE, UL/

cUL, CB

* Sustained Rate - maximum constant log message rate that the FAZ platform can maintain for minimum 48 nours without SQL database and system performance degradation.

** s the max number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate (s lower.

=% Gen2 refers to hardware that has been upgraded since initial release.

**#%3700G must connect to a 200V - 240V power source.
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FortiAnalyzer "

Ordering Information

Product

FortiAnalyzer

FortiAnalyzer-VM Subscription
License with Support

FortiAnalyzer-VM

FortiAnalyzer Cloud Sterage
Subscription

FortiAnalyzer - Backup to Cloud
Service

FortiAnalyzer Cloud with SOCaa$
FortiAnalyzer Cloud

Security Automation Service

FortiGuard |OC and Outbreak
Detection Service

OT Security Service

FortiAnalyzer Security Rating and
Compliance Service

Enterprise Protection Bundie

Hardware Bundle

SKU

FAZ-150G
FAZ-300G
FAZ-810G

FAZ-1000G

FAZ-3100G

FAZ-3510G

FAZ-3700G

FC1-10-AZVMS-465-01-DD

FC2-10-AZVYMS-485-01-DD

FC3-10-AZVMS-465-01-DD

FAZ-VM-GB1
FAZ-VM-GBS
FAZ-YM-GB25
FAZ-YM-GB100
FAZ-VM-GBS00

FAZ-VYM-GB2000
FC1-10-AZCLD-463-01-DD

FC2-10-AZCLD-463-01-DD

FC3-10-AZCLD-463-01-DD

FC-10-FAZ00-288-02-DD

FC-10-[Model Code]-464-02-DD

FC-10-[Model Code]-585-02-DD

FC-10-[Model Code]-335-02-DD
FC[GB Day Code]-10-LVOVM-335-02-DD
FC-10-[Model Code]-661-02-DD
FC[GB Day Code]-10-LVOVM-661-02-DD
FC-10-[Model Code]-159-02-DD

FC-10-[Model Code]-175-02-DD

FC-10-[Model Code]-466-02-DD

FAZ-[Hardware Model]-BDL-466-DD

y Fabric Natwe

Data Sheet

i Araly ucs and Aulomation

Description
Centralized log and analysis appliance — 2x RJ45 GE, 4 TB storage, up to 25 GB/ day of iogs.
Centralized log and analysis appliance — 4x RJA5 GE, 8 TB storage, up to 100 GB/ day of logs.

Centralized log and analysis appliance — 4x GE, 2x SFP, 16 TB self-encrypting storage, up to
200 GB/ day of logs.

Centralized logging and analysis appliance - 2x 2.5GbE RJ45 + 2x 25GbE SFP28, 32TB storage, up to
660 GB/Day of Logs.

Centralized log and analysis appliance — 2x GE RJ45, 2x 25GE SFP28, 64 TB storage, dual power
supplies, up to 3000 GB/ day of logs.

Centralized log and analysis appliance — 2x 10GbE RJ45, 2x 25GbE SFP28, 96 TB storage, up to
5000 GB/ day of logs.

Centralized log and analysis appliance - 2x 10GE RJ-45 + 2x 25GE SFP28 slots, 240TB HDD + 19.2TB
NVMe SSD storage, up to 8300 GB/ day of Logs.

Subscription license for 5 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Outbreak Detection service.

Subscription license for 50 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Outbreak Detecticn service.

Subscription license for 500 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
I0C, Security Automation Service, and FortiGuard Outbreak Detection service.

Upgrade iicense for adding 1 GB/Day of Logs.
Upgrade license for adding 5 GB/Day of Logs.
Upgrade license for adding 25 GB/Day of Logs.
Upgrade license for adding 100 GB/Day of Logs.
Upgrade license for adding 500 GB/Day of Logs.

Upgrade license for adding 2 TB/Day of Logs.

Increase FortiAnalyzer Cloud storage by 5 GB/Day for Central Logging and Analytics and FortiCloud
SOCasS. Include FortiCare Premium support, I0C and Security Automation Service.

Increase FortiAnalyzer Cloud storage by 50 GB/Day for Central Logging and Analytics and FortiCloud
SOCaaS. Include FortiCare Premium support, IOC and Security Automation Service.

Increase FortiAnalyzer Cloud storage by 500 GB/Day for Central Logging and Analytics and FortiCloud
SOCaasS. Include FortiCare Premium support, IOC and Security Automation Service.

One year subscription to FortiAnalyzer storage connector service for 10TB data transfer to public cloud.

FortiAnalyzer Cloud with SOCaa$S: cloud-based central logging and analytics. Inciude All FortiGate log
types, 10C service, Security Automation Service, FortiGuard Outbreak Service and SOCaaS.

FortiAnalyzerCloud: cloud-based central logging and analytics. Include all FortiGate log types, I0C
service, Security Automation Service, FortiGuard Outbreak Detection Service.

Subscription license for Security Automation Service - Appliance.

Subscripticn license for Security Automatien Service - Virtual Machine.

Subscription license for FortiGuard I0C and Outbreak Detection Service - Appliance.
Subscription license for FortiGuard IOC and Outbreak Detection Service - Virtual Machine.

OT Security Service including advanced OT analytics, risk and compliance reports, event handlers, and
use-case correlation rules.

Subscription license for FortiAnalyzer Security Rating and Compliance Service.
Enterprise Protection (FortiCare Premium plus Indicators of Compromise Service, Security Automation
Service, and FortiGuard Outbreak Detection service).

Hardware plus FortiCare Premium and FortiAnalyzer Enterprise Protection.
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Fortinet Corporate Social Responsibility Policy

Fortinet is committed to driving progress and sustainability for all through cybersecurity, with respect for human rights and
ethical business practices, making possible a digital world you can always trust. You represent and warrant to Fortinet that you
will not use Fortinet’s products and services to engage in, or support in any way, violations or abuses of human rights, including
those involving illegal censorship, surveillance, detention, or excessive use of force. Users of Fortinet products are required

to comply with the Fortinet EULA and report any suspected violations of the EULA via the procedures outlined in the Fortinet
Whistleblower Palicy.
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Setting up FortiAnalyzer

Avatars

When FortiClient sends logs to FortiAnalyzer, an avatar for each user can be displayed in the Source column in the

FortiView and Log View panes. FortiAnalyzer can display an avatar when FortiClient is managed by FortiGate or
FortiClient EMS with logging to FortiAnalyzer enabled.

« When FortiClient Telemetry connects to FortiGate, FortiClient sends logs (including avatars) to FortiGate, and the
logs display in FortiAnalyzer under the FortiGate device as a sub-type of security.

The avatar is synchronized from FortiGate to FortiAnalyzer by using the FortiOS REST API.

« When FortiClient Telemetry connects to FortiClient EMS, FortiClient sends logs (including avatars) directly to
FortiAnalyzer, and logs display in a FortiClient ADOM.

If FortiAnalyzer cannot find the defined picture, a generic, gray avatar is displayed.

AL
‘9' You can also optionally define an avatar for FortiAnalyzer administrators. See
- Creating administrators on page 351.

Showing and hiding passwords

In some cases you can show and hide passwords by using the toggle icon. When you can view the password, the Toggle
show password icon is displayed:

Password @

When you can hide the password, the Toggle hide password icon is displayed:

Passwora asen o

Target audience and access level

This guide is intended for administrators with full privileges, who can access all panes in the FortiAnalyzer GUI, including
the System Settings pane.

In FortiAnalyzer, administrator privileges are controlled by administrator profiles. Administrators who are assigned
profiles with limited privileges might be unable to view some panes in the GUI and might be unable to perform some
tasks described in this guide. For more information about administrator profiles, see Administrator profiles on page 358.

s‘;", Ifyou logged in by using the admin administrator account, you have the Super_User

administrator profile, which is assigned to the admin account by default and gives the admin
administrator full privileges.

Initial setup

This topic provides an overview of the tasks that you need to do to get your FortiAnalyzer unit up and running.

{

FortiAnalyzer 7.2.2 Administration Guide
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FortiAnalyzer Key Concepts

) : /, ADOMs must be enabled to support FortiCarrier, FortiClient EMS, FortiMail, FortiWeb,
9 FortiCache, and FortiSandbox logging and reporting. See Administrative Domains (ADOMs)
= on page 296.

Logs

Logs in FortiAnalyzer are in one of the following phases.

» Real-time log: Log entries that have just arrived and have not been added to the SQL database. These logs are
stored in Archive in an uncompressed file.

» Archive logs: When areal-time log file in Archive has been completely inserted, that file is compressed and
considered to be offline.

« Analytics logs or historical logs: Indexed in the SQL database and online.

In order for FortiAnalyzer to accept logs, the sending device must be registered in FortiAnalyzer. You can add devices to
FortiAnalyzer by specifying the serial number and other details, or you may point the device’s log settings to the
FortiAnalyzer. Ifinitiated by the remote device, the device must be authorized before logs can be received on
FortiAnalyzer. See Adding devices on page 41.

For more information on the types of logs collected for each device, see Types of logs collected for each device on page
88.

Log encryption — 5

Beginning in FortiAnalyzer 6.2, all logs from Fortinet devices (using Fortinet's proprietary protocol: OFTP) must be
encrypted. FortiAnalyzer encryption level must be equal or less than the sending device’s level. For example, when
configuring logging from a FortiGate, FortiAnalyzer must have the same encryption level or lower than FortiGate in order
to accept logs from FortiGate.

To configure the encryption level on FortiAnalyzer:
1. Inthe FortiAnalyzer CLI, enter the following commands:

config system global
set enc-algorithm {high | low | medium}

To configure the encryption level on FortiGate:

1. Inthe FortiGate CLI, enter the following commands:
config log fortianalyzer setting
set enc-algorithm {high-medium | high | low}

See also Appendix B - Log Integrity and Secure Log Transfer on page 405.

Log storage

Logs and files are stored on the'FortiAnalyzer disks. Logs are also temporarily stored in the SQL dgtabase.

FortiAnalyzer 7.2.2 Administration Guide
Fortinet Inc. pagel2



FortiView dashboards for FortiGate and FortiCarrier devices

Description

Threats

‘ Top Threats

Threat Map

Compromised Hosts

FortiSandbox
Detection

FortiAnalyzer 7.2.2 Administration Guide

Fortinet Inc.

. The following incidents are considered threats:

« Risk applications detected by application control.
e Intrusion incidents detected by IPS.

* Malicious web sites detected by web filtering.

« Malware/botnets detected by antivirus.

| Displays a map of the world that shows the top traffic destinations starting

at the country of origin. Threats are displayed when the threat score is
greater than zero and either the source or destination IP is a public IP

| address.
' The Threat Window below the map, shows the threat, source, destination,

severity, and time. The color gradient of the lines indicate the traffic risk. A
yellow line indicates a high risk and a red line indicates a critical risk.

This view does not support filtering and Day, Night, and Ocean themes.
See also Viewing the threat map on page 58.

Displays end users with suspicious web use compromises, including end

users’ IP addresses, overall threat rating, and number of threats.

To use this feature:

1. UTMlogs of the connected FortiGate devices must be enabled.

2. The FortiAnalyzer must subscribe to FortiGuard to keep its threat
database up-to-date.

Displays a summary of FortiSandbox related detections.

The following information is displayed: Filename, End User and/or IP,
Destination IP, Analysis (Clean, Suspicious or Malicious rating), Action
(Passthrough, Blocked, etc.), and Service (HTTP, FTP, SMTP, etc.).

Select an entry to view additional information in the drilldown menu.

Clicking a FortiSandbox action listed in the Process Flow displays details
about that action, including the Overview, Indicators, Behavior Chronology
Chart, Tree View, and more. Information included in the Details and Tree
View tab is only available with FortiSandbox 3.1.0 and above.
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Category

—_— 8
Traffic

Shadow IT

_\8

Applications &
Websites

Fortinet Inc.

Top Sources

Top Source

‘ Addresses

- Top Destinations

Top Destination
Addresses

Top Country/Region

Policy Hits

DNS Logs

" ZTNA Servers

Top Cloud
Applications

Top Cloud Users
Top Applications

Top Website
Domains

Top Website
Categories

Top Browsing Users

FortiAnalyzer 7.2.2 Administration Guide

Description

Displays the highest network traffic by source IP address and interface,
device, threat score (blocked and allowed), sessions (blocked and
allowed), and bytes (sent and received).

' Displays the top source addresses by source object, interface, device,

threat score (blocked and allowed), sessions (blocked and allowed), and
bytes (sent and received).

Displays the highest network traffic by destination IP addresses, the
applications used to access the destination, sessions, and bytes. If
available, click the icon beside the IP address to see its WHOIS
information.

. Displays the top destination addresses by destination objects,

applications, sessions, and bytes. If available, click the icon beside the IP
address to see its WHOIS information.

Displays the highest network traffic by country in terms of traffic sessions,
including the destination, threat score, sessions, and bytes.

Lists the policy sessions by policy, device name, VDOM, number of hits,
bytes, and last used time and date.

Summarizes the DNS activity on the network. Double click an entry to drill
down to the specific details about that domain.

. ZTNA servers by bytes.

. Displays the top cloud applications used on the network.

When viewing information about an application, FortiAnalyzer will first
check the Shadow IT database, and if no results are found, it will use the
metadata.

Displays the top cloud users on the network.

Displays the top applications used on the network including the application
name, category, risk level, and sessions blocked and allowed. Bytes sent
and received can also be enabled through the widget settings. Top
Applications can be viewed as a stackbar, bar, table, or bubble chart.

For a usage example, see Finding application and user information on

page 68.

Displays the top allowed and blocked website domains on the network.

Displays the top website categories.

Displays the top web-browsing users, including source, group, number of
sites visited, browsing time, and number of bytes sent and received.
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Category | Description

Displays the users who are accessing the network by using the following
types of security over a virtual private network (VPN) tunnel: secure socket
layers (SSL) and Internet protocol security (IPsec).
SSL &DialupIPsec ' You can view VPN traffic for a specific user from the top view and drilldown
VPN | views. In the top view, double-click a user to view the VPN traffic for the
specific user. In the drilldown view, click an entry from the table to display
the traffic logs that match the VPN user and the destination.

Site-to-Site |Psec Displays the names of VPN tunnels with Internet protocol security (IPsec)
' that are accessing the network.
- Admin Logins Displays the users who logged into the managed device.
— 8 System Events Displays events on the managed device.

. Displays device CPU, memory, logging, and other performance
information for the managed device.

Resource Usage
e g Resource Usage includes two widgets: Resource Usage Average and

Resource Usage Peak.

Failed . . .

L Displays the IP addresses of the users who failed to log into the managed

Authentication ;
device.

Attempts

Using FortiView

When ADOMs are enabled, FortiView displays information for each ADOM. Please ensure you are in the correct ADOM.
See Switching between ADOMs on page 26.

» Viewing FortiView dashboards on page 57

» Filtering FortiView on page 59

« Viewing related logs on page 59

» Exporting filtered summaries on page 59

« Monitoring resource usage of devices on page 60
o Long-lived session handling on page 60

Viewing FortiView dashboards

When viewing FortiView dashboards, use the controls in the toolbar to select a device, specify a time period, refresh the
view, and switch to full-screen mode.

Many widgets on FortiView dashboards let you drill down to view more details. To drill down to view more details, click,
double-click, or right-click an element to view details about different dimensions in different tabs. You can continue to drill
down by double-clicking an entry. Click the close icon in the widget's toolbar to return to the previous view.

Many FortiView widgets support multiple chart types such as table view, bubble view, map view, tile view, etc.

« In widgets that support multiple views, select the settings icon in the top-right corner of the widget to choose another
view.

FortiAnalyzer 7.2.2 Administration Guide
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SD-WAN Bandwidth
Overview

SD-
WAN Performance
Status

SD-WAN Rules
Utilization

SD-WAN Utilization
by Application

Top SD-WAN
SLA Issues

Health Check Status

SD-WAN Events

Application
Bandwidth
Utilization

Per-Application
Performance

Global-Application
Performance

SD-WAN Interfaces

Audio MOS Score

The bandwidth of the SD-WAN network over time. This widget displays a line chart of the
sent/received rate (bps) in the selected time period for SD-WAN members interfaces.

The SD-WAN performance status comparison with interfaces. Mousing over the scatter
chart displays the status for health checks and member interface in a tooltip. The colors (red,
orange, yellow, and green) indicate the different percentage of a member's interface or
health check. Click on a scatter chart to view additional details.

The SD-WAN rule traffic utilization by interface and application.

The share of bandwidth utilization by application for each WAN link.

The top SD-WAN SLA issues.

This widget dynamically creates a child-widget for each health check where a line chart of
latency, jitter, and packet loss in the selected time period for SD-WAN interfaces is
displayed.

This widget displays a table chart for SD-WAN event logs which have a level higher than
notice (warning, error, etc.) within the selected time period.

The total bandwidth from all applications as well as the bandwidth per-SD-WAN interface.
This widget can be viewed in a sanky chart or table chart format.

The performance for the selected application based on chosen metric. You can select an
application in the widget's Application dropdown menu.

Latency, Jitter, Packet Loss, and Bandwidth metrics are available.

The global application performance for the selected metric.
Latency, Jitter, and Packet Loss metrics are available.

The information for SD-WAN interfaces and ADVPN shortcut interfaces.
Latency, Jitter, and Packet Loss metrics are available.

The MOS score by interface. Mousing over the chart displays a summary of the MOS score
and VolP quality at that point.

The interface must have a performance SLA with MOS enabled to display in the chart.

To update the Refresh Interval, click the settings icon at the top of the widget, and then selecta
value from the dropdown.

To filter a chart, click a key in the legend.

R

SD-WAN Summary

SD-WAN Summary monitor includes the following widgets:

SD-WAN Health Overview The SD-WAN devices' status.

FortiAnalyzer 7.2.2 Administration Guide
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Log View and Log Quota Management

device(s) and time frame for the event logs.

The Total Events widget on this dashboard displays a line chart of event logs by level. You can hover your cursor over
the line chart to display a summary of the count and time at that point.

The other widgets on this dashboard list the event names for the displayed event types. These widgets can be toggled
on/off from the Toggle Widgets dropdown. By clicking an event name in the widget, you can open a list view of those
event logs filtered by the devices and time frame you selected on the dashboard.

Toggle Widgets v Al FortiGate ¥ @ Last 4 Hours v 2022-02-10 132400 - 2022-02-10 17.24.00

Total Events

ﬂSystemEvems . EVPN Events .
Event Name
¥ e 0 o et

Lovel Count Event Name Level Count
ot 240 - oo w 20—
b 196 mmm e 168 o——
" 195 - w 108 mwern
& — ¥ 108 = =]
- . £ =
50 — e 22 -
= e 12 "
o - iy 10 ]
P i ote 1 a1 kb eror 1
= =g N . N AN ¢ bt 1 i
SD-WAN Events . User Events .
Event Name Level Count Event Name Level Count
WAN i e BT — No record found.

Viewing historical and real-time logs

By default, Log View displays historical logs. Custom View and Chart Builder are only available in historical log view.
To view real-time logs, in the log message list view toolbar, click Tools > Real-time Log.

To switch back to historical log view, click Tools > Historical Log.

Viewing raw and formatted logs

By default, Log View displays formatted logs. The log view you select affects available view options. You cannot
customize columns when viewing raw logs.

To view raw logs, in the log message list view toolbar, click Tools > Display Raw.
To switch back to formatted log view, click Tools > Formatted Log.

For more information about FortiGate raw logs, see the FortiGate Log Message Reference in the Fortinet Document
Library. For more information about raw logs of other devices, see the Log Message Reference for the platform type.

FortiAnalyzer 7.2.2 Administration Guide
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Incident and Event Management

Option Description

e Match Criteria: Select an operator from the dropdown.
e Value: Select the event type from the dropdown.
To delete a condition, click the delete icon next to the condition.

Generic Text Filter  (Optional) Enter a filter string. For more information, see Using the
Generic Text Filter on page 177.

Creating notification profiles

Notification profiles are used to send alert notifications when an event is generated by an event handler. You can
configure the notification profile to send the alert to an email address, SNMP community, and/or syslog server. You can
also configure the notification profile to send the alert through a fabric connector.

You can create, edit, clone, and delete notification profiles in FortiSoC/Incidents & Events > Handlers > Notification
Profile List.

To assign a notification profile to a basic event handler, see Creating a custom event handler on page 168.

To assign a notification profile to a correlation handler, see Creating a custom correlation handler on page 171.

To create a notification profile:

1. Goto FortiSoC/Incidents & Events > Handlers > Notification Profile List.
2. Click Create New.
The Add New Notification Profile pane displays.

3. Configure the following options, and click OK to save the notification profile.

Option Description

Name Enter a name for the notification profile.
Send Alert through Fabric Send an alert through one or more fabric connectors selected from the
Connectors dropdown. Click the plus (+) to add fabric connectors. For more information,

see Fabric Connectors on page 112.

Send Alert Email Send an alert to one or more email addresses. Specify the email parameters,
including the mail server. For more information, see Mail Server on page 333.

To Enter the email address(es) to send the alert to. Use a semicolon (;) to
separate multiple email addresses.

From Enter a from address for the alert email.
Subject Enter a subject line for the alert email.
Email Server Select the mail server for the alert email.
Send SNMP(...) Trap Send an alert to an SNMP community or user selected from the dropdown. For

more information, see SNMP on page 324.

FortiAnalyzer 7.2.2 Administration Guide
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FortiSoC

FortiSoC is a subscription service that enables playbook automation for security operations on FortiAnalyzer.

FortiAnalyzer's SIEM capabilities parse, normalize, and correlate logs from Fortinet products and the security event log
of Windows and Linux hosts (with Fabric Agent integration). Parsing is predefined by FortiAnalyzer and does not require
manual configuration by administrators. SIEM logs are displayed as Fabric logs in Log View and can be used when
generating reports. See Types of logs collected for each device on page 88.

FortiSoC provides incident management capabilities with playbook automation to accelerate incident response. When
FortiAnalyzer has a valid subscription license, the FortiSoC module is activated and administrators are able access
playbook automation features. Task automation can be configured by SOC analysts using playbooks which consist of a
trigger and sequence of automated actions. Playbooks can be created from scratch or by using one of the predefined
templates. Fabric connectors further enhance FortiSoC functionality by allowing playbooks to perform tasks using
connected devices, including FortiOS and FortiClient EMS.

N ! 2, FortiSoC includes a trial with a limited capacity allowing up to five playbooks per day.
9 A SOC subscription is required to run at full capacity. For additional information about
- licensing, please see support fortinet.com.
\‘ : ’I
9 For information about FortiSoC incidents and events, see Incident and Event Management on
oo page 135.

Viewing FortiSoC dashboards

FortiSoC includes multiple dashboards for viewing information about playbooks, incidents, and events.

There is a toolbar available for each dashboard, providing the following options:

Dark Mode Enable/disable dark mode. Dark mode shows a black background for the
dashboard.
Refresh From the Refresh dropdown in the toolbar, you can select a frequency for the

dashboard to automatically refresh the information. If you need to manually
refresh the dashboard before itis done automatically, click Refresh in the toolbar.

By default, the refresh frequency is set to Manual Refresh. Click Refresh in the
toolbar to refresh the dashboard when needed.

ST T T R Y

!
_;i
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~12

Playbooks

I Total Playb

} 280

280

Playbooks Executed

Total Playbook Actions Executed

623

Total Executed Playbooks and Actions

The Playbooks dashboard includes:

Total Playbooks Executed The total number of playbooks executed.

Total Playbook Actions The total number of playbook actions (tasks) executed.

Executed

Playbooks Executed The number of times each playbook has been run.

Overall Time Saved The estimated time saved by administrators resulting from FortiSoC automation.

Total Executed Playbooks and A timeline of the number of playbooks and actions run for each day. Both actions
Actions and playbooks can be toggled on or off in the graph by clicking the corresponding
name below the graph.
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Incidents — 12

Total Incidents

The Incidents dashboard includes:

Total Incidents
Unsolved Incidents

Incidents Timeline

Events Sl

Total Events Generated

Events by Severity,

The Events dashboard includes:

FortiAnalyzer 7.2.2 Administration Guide
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2 28 High
« Medium

Unsolved Incidents = Lo

incidents Timeline

-

Displays the total number of incidents created by their status.
Displays the total number of unsolved (not closed) incidents by severity.

Total incidents breakdown by category trend by day.

Top Events by Type

Application Control

Web Filter |

Top Events by Handler

Default FOS Svstern Events

196
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FortiSoC

Outbreak Alerts

The FortiAnalyzer Outbreak Detection Service is a licensed feature that allows FortiAnalyzer administrators to view
outbreak alerts and automatically download related event handlers and reports from FortiGuard.

When FortiAnalyzer has a valid license for the Outbreak Detection Service, outbreak alerts from Fortinet are displayed in
the FortiSoC > Outbreak Alerts pane. Outbreak alerts can be viewed from any ADOM. You can navigate between
outbreak alerts by clicking on the corresponding tab at the top of the pane, and click the download icon to download a
copy of the outbreak alert.

Outbreak event handlers and reports are created in real-time by Fortinet to detect and respond to emerging outbreaks.
Outbreak reports and event handlers are automatically downloaded so that they are available in your environment. See
Viewing imported event handlers and reports on page 212.

Without a valid license for the Outbreak Detection Service, Outbreak Alerts displays a default alert page, and outbreak
event handlers and reports are not available from FortiGuard. To obtain a valid license for FortiAnalyzer Outbreak
Detection Service, contact Fortinet FortiCare.

Viewing imported event handlers and reports

With a valid license, the FortiAnalyzer Outbreak Detection Service automatically downloads event handlers and reports
created by Fortinet in response to known outbreaks. This section includes information on how to view downloaded
outbreak event handlers and reports.

To view outbreak event handlers and reports:

1. Goto FortiSoC > Handlers > Event Handler List.
Event handlers created by the FortiAnalyzer Outbreak Detection Service are displayed with the Outbreak Alert
prefix. See Event handlers on page 135.

4 Creata New [4 Edit ¥ Deletr % Clone § More ~

O Vv Satus Name Filters. Devices Send Alert to Events. Included Subnets. Excluded Subnets

Q060000000000

TR O gle

De 7V Compromese tection 10C By Ernapant

2. Goto Reports > All Reports.

The Outbreak Alert Reports folder includes available reports from the FortiAnalyzer Outbreak Detection Service.

FortiAnalyzer 7.2.2 Administration Guide
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Reports can be run in HTML, PDF, XML, CSV, and JSON output formats. See Generating reports on page 215.

More v [ Show Scheduled Only .

o
s}
o
a

CESTERT IRy,
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System Settings

Viewing a CRL

To view a CRL:

Go to System Settings > Certificates > CRL.

Select the CRL you need to see details about.

Click View Certificate Detail in the toolbar, or right-click and select View Certificate Detail. The Result page opens.
Click OK to return to the CRL list.

Lol

Deleting a CRL

To delete a CRL or CRLs:

Go to System Settings > Certificates > CRL.

Select the CRL or CRLs you need to delete.

Click Delete in the toolbar, or right-click and select Delete.

Click OKin the confirmation dialog box to delete the selected CRL or CRLs.

Mo N

Log Forwarding

You can forward logs from a FortiAnalyzer unit to another FortiAnalyzer unit, a syslog server, or a Common Event
Format (CEF) server when you use the default forwarding mode in log forwarding.

The client is the FortiAnalyzer unit that forwards logs to another device. The serveris the FortiAnalyzer unit, syslog
server, or CEF server that receives the logs.

In addition to forwarding logs to another unit or server, the client retains a local copy of the logs. The local copy of the
logs is subject to the data policy settings for archived logs. See Log storage on page 33 for more information.

To see a graphical view of the log forwarding configuration, and to see details of the devices
involved, go to System Settings > Logging Topology. For more information, see Logging
Topology on page 285.

Modes

FortiAnalyzer supports two log forwarding modes: forwarding (default), and aggregation.

Forwarding

Logs are forwarded in real-time or near real-time as they are received. Forwarded content files include: DLP files,
antivirus quarantine files, and IPS packet captures.

This mode can be configured in both the GUI and CLI.

FortiAnalyzer 7.2.2 Administration Guide
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Administrators

Force this administrator to
change password upon next
log on.

FortiToken Cloud

Administrative Domain

Admin Profile

JSON API Access

Trusted Hosts

Theme Mode

Meta Fields

Advanced Options

FortiAnalyzer 7.2.2 Administration Guide
Fortinet Inc.

Force the administrator to change their password the next time that they log in
to the FortiAnalyzer.

This option is only available if Password Policy is enabled in Admin Settings.
See Password policy on page 382.

Enable or disable two-factor authentication with FortiToken Cloud, then select
the token delivery method from the following options:

e FortiToken Mobile: Use the FortiToken Mobile app to get tokens. The
administrator is sent an email with a link to activate their token in the
FortiToken Mobile app on their mobile device.

¢ Email: Receive the token by email.

e SMS: Receive the token by SMS message.

This option is not available if Admin Type is set to PK/ or SSO. See Two-factor
authentication on page 385.

Choose the ADOMs this administrator will be able to access.
* All ADOMs: The administrator can access all the ADOMs.
» All ADOMs except specified ones: The administrator cannot access the
selected ADOMs.
¢ Specify. The administrator can access the selected ADOMs. Specifying
the ADOM shows the Specify Device Group fo Access check box. Select
the Specify Device Group to Access check box and select the Device
Group this administrator is allowed to access. The newly created
administrator will only be able to access the devices within the Device
Group and sub-groups.
If the Admin Profile is Super_User, then this setting is All ADOMs.
This field is available only if ADOMs are enabled. See Administrative Domains
(ADOMSs) on page 296.

Select an administrator profile from the list. The profile selected determines
the administrator’s access to the FortiAnalyzer unit's features. See
Administrator profiles on page 358.

Select the permission for JSON API Access. Select Read-Write, Read, or
None. The defaultis None.

Optionally, turn on trusted hosts, then enter their IP addresses and netmasks.
Up to ten IPv4 and ten IPv6 hosts can be added.

See Trusted hosts on page 349 for more information.

Select Use Global Theme to apply a theme to all administrator accounts.
Select Use Own Theme to allow administrators to select their own theme.

Optionally, enter the new administrator's email address and phone number.

Configure advanced options, see Advanced options below.

For more information on advanced options, see the FortiAnalyzer CL/
Reference.
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Highlights

m Centralized network
monitoring and visibility

® Advanced threat and
vulnerability detection
with event and log data
correlation

® Augmented NOC/SOC
operations for real-time
response, analytics, and
reporting

® Automation to save
time, reduce errors, and
improve efficiency

= Multi-tenancy solution
with quota management

® Administrative domains
for operational
effectiveness and
compliance

= 70+ reports and 2000+
ready-to-use datasets,
charts, and macros
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Analytics, Reports, and Compliance Across the Security Fabric

FortiAnalyzer is a powerful log management, analytics, and reporting
platform that provides organizations with a single console to manage,
automate, orchestrate, and respond, enabling simplified security
operations, proactive identification and remediation of risks, and

complete visibility of the entire attack landscape.

Integrated with the Fortinet Security Fabric, FortiAnalyzer enables

Network and Securitg.oﬂperations Teams with real-time detection

capabilities, centralizjgz : vtg,énalytics and end-to-end security
posture awareness to help analysts identify advanced persistent

threats (APTs) and mitigate risks before a breach can occur.
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Capabilities

Incident Detection and Response

Centralized NOC/SOC Visibility for the Attack Surface

FortiAnalyzer provides Security Fabric Analytics across all device logs with event correlation
and real-time detection of Advanced Persistent Threats (APTs), vulnerabilities and Indicators
of Compromise (I0C) for FortiGate NGFWs, FortiClient, FortiSandbox, FortiWeb, FortiMail and
other Fortinet products, for deep visibility and critical network insights. Simplified orchestration
and automated workflows provide Network Security Operations teams with real-time
notifications, reports, and dashboards for single-pane visibility and actionable results.

Incidents and Events Management

Security teams can monitor and manage alerts and event logs from Fortinet devices, with
events processed and correlated in a format that analysts can easily understand. Investigate
suspicious traffic patterns and search using filters in predefined or custom event handlers to
generate real-time notifications and monitoring for NOC and SOC operations, SD-WAN, SSL
VPN, wireless, Shadow IT, IPS, network recon, FortiClient, and more.

The Incidents component enables analysts to manage incident handling and life cycle, with
incidents generated by events that show affected assets, endpoints, users and timelines.

Fabric Automation

FortiAnalyzer Playbooks boost an organization’s security team abilities to simplify investigation
efforts through automated incident response, freeing up resources and allowing analysts to
focus on critical tasks. Out-of-the-box playbook templates enable SOC analysts to quickly
customize their use cases, define custom processes, interact with other Security Fabric
devices like FortiOS and EMS, edit playbooks and tasks in the visual playbook editor and use
the Playbook Monitor for investigation of compromised hosts, infections and critical incidents,
data enrichment for Assets and Identity views, blocking malware, C&C IPs, and more.

Security Fabric Analytics

Analytics and Reporting

FortiAnalyzer automation driven analytics empowers network security operations teams to
complete a fast assessment of network devices, systems, and users, with correlated log data
and FortiGuard threat intelligence for analysis of real-time and historical events.

»  FortiView Monitors and Views provide deep insights with context and meaning of network
activity, risks, vulne abilities, attack attempts, indicators of compromise and anomalies,
sanctioned and ufsd oned.’u‘é,ﬁr activity.

i W & L |

¢ Log View enabie*gi lys ek_‘and their investigation and utilize search filters on
managed device I'"o‘g drilFdown on logs, with custom views and log groups, including a
SIEM database with normalized logs for Fortinet devices in Fabric ADOMs.

» Reports provide comprehensive analysis of your Security Posture, including reports for
Operational Technology (OT), security rating, security rating for PCI, Secure SD-WAN, VPN,
FortiNDR network anomaly detection, cyber threat assessments, 360 Security Reviews,
situational awareness, compliance, auditing, and more.
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Capabilities

Assets and Identity

FortiAnalyzer Fabric View with Assets and Identity monitoring provides SOC teams with
elevated awareness and visibility into an organization’s endpoints and users with dashboards
and correlated device and UEBA information, vulnerability detections, EMS tagging, and asset
classifications through telemetry with EMS, NAC, Fortinet Fabric Agent, and an OT Dashboard
View.

Avtet Kentification Unidentified Asset Activity

terprise_FortiAnalyzer

Search a
3CX Supply Chain Atk FAnTIET

wsscne | QOUTBREAK ALERTS :

Reaitek SDK Amack

Teciib GLPI Remmote Code Exe
Joomial CMS lmproper Accest Emotet Malwa re Resurgence |

Progreess Telertk U Aztackc

First wave of the year 2023

nips sren wdpecia crgam Emate!

1BM Aspera Faspex Code Exat
Cacti Command Injection Yuh
Emotet. a Troan that is distnbuted via spam emaiis. has been prevalent since its first appearance in 2014 With a nefwork mace up of multiple
ootnets, Emotet has continuousiy sent out spam emads in campaigns designad fo infect users via phishing attacks.

Fortra GoAnywhere MFT RCE

WMware ESXi Server Ranscrm

Background The EuroPoi has considersd Emotet as one of the worid's most dangerous matware it vas first discovered on
OQutbreak Alert- 2022 Annual vear 2014 as a Banking Troian This report focusses specically on the Emotet maiware orotection and I0C
detections by the Sect Fi odu

WP Contrel Web Panet o ons by the Secunty Faonc products

i
Zercbot Attack 1
Announced March 7 2023 After several months of inactivity, the Emotet botnet resumed emali activity and v/as seen l

addoi'la neww methods of evasion by using Microsoft OneNote attachments and archive bomps.
- colgnse ARG Sl -RECTe {h-niatus

YMuiare Sprng Cloud

Generic Web Application Fire:
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Subscriptions and Extensions

Subscription Licenses and FortiGuard Security Services

e FortiGuard Outbreak Detection Service delivers automated content package download
for detecting the latest malware, including a summary of outbreaks and kill chain mapping
for how the malware works. The package includes a FortiGuard Report for the outbreak,
Event Handler, and a Report Template to detect outbreaks.

» FortiGuard Indicators of Compromise Service-empowers security teams with forensic
data from 500 000 10Cs daily, used in combination with FortiAnalyzer analytics to identify
suspicious usage and artifacts observed on the network or in an operations system, that
have been determined with high confidence to be malicious infections or intrusions, and
historical rescan of logs for threat hunting.

« Shadow IT Monitoring Service provides continuous monitoring of unapproved devices,
resources, unsanctioned accounts and unauthorized use of SaaS and laaS, APl integration,
and third party apps. The service identifies rogue users using personal accounts for
managing company assets, using correlated FortiOS and FortiCASB data with a FortiCASB
account subscribed for Saas features.

= OT Security Service provides security teams with advanced OT analytics, risk and
compliance reports, OT event handlers, and use-case correlation rules.

»  Security Rating and Compliance Service helps security teams design, implement, and
maintain their security posture, and provides actionable configuration recommendations as
well as key performance and risk indicators.

= Security Automation Service subscription enables further automation for incident
response with enhanced monitoring and escalation, built-in incident management
workflows, connectors, playbooks and more.

Management Extension Applications (MEAs)

The Management Extensions pane allows you to enable licensed applications that are
released and signed by Fortinet, which can be installed and run on FortiAnalyzer, including the
FortiSIEM and FortiSOAR.
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Deploying FortiAnalyzer

FortiAnalyzer can be deployed as a physical hardware appliance, virtual machine (VM) and
virtual machine subscription (VM-S), as well as private or public cloud instance, with scalability,
redundancy and backup, and high availability capabilities.

FortiAnalyzer High Availability (HA)

FortiAnalyzer HA provides real-time redundancy to protect organizations by ensuring
continuous operational availability. In the event that the primary (active) FortiAnalyzer fails,
a secondary (passive) FortiAnalyzer (up to four-node cluster) will immediately take over,
providing log and data reliability and eliminating the risk of having a single point of failure.

Multi-Tenancy with Flexible Quota Management

FortiAnalyzer provides the ability to manage multiple sub-accounts with each account
having its own administrators and users. The time-based archive/analytic log data policy, per
Administrative Domain (ADOM), allows automated quota management based on the defined
policy, with trending graphs to guide policy configuration and usage monitoring.

Analyzer Collector Modes

FortiAnalyzer provides two operation modes: Analyzer and Collector. In Collector mode, the
primary task is forwarding logs of the connected devices to an Analyzer and archiving the logs.
This configuration greatly benefits organizations with increasing log rates, as the resource
intensive log-receiving task is off-loaded to the Collector so that the Analyzer can focus on
generating analytics and reports.

Network operations teams can deploy multiple FortiAnalyzers in Collector and Analyzer modes
to work together to improve the overall performance of log receiving and processing increased
log volumes, providing log storage and redundancy, and rapid delivery of critical network and
threat information.

FortiAnalyzer Fabric

FortiAnalyzer Fabric allows SOC Administrators to configure two operation modes - Supervisor
and Member. This allows viewing of member devices, ADOMs and authorized logging devices,
as well as incidents and events created on members. Admins get access to Reports and
FortiView across all member FortiAnalyzers, and can perform global search in Log View of logs
collected across FortiAnalyzer Fabri¢ members with pre-defined device filters and log drill

down for each Member and Member ADOMS, .

Log Forwarding for Third-Party Integration

Forward logs from one FortiAnalyzer to another FortiAnalyzer unit, a syslog server, or (CEF)
server. In addition to forwarding logs to another unit or server, the client FortiAnalyzer retains a
local copy of the logs, which are subject to the data policy settings for archived logs. Logs are
forwarded in real-time or near real-time as they are received from network devices.
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Cloud Services

FortiAnalyzer Cloud

FortiAnalyzer Cloud offers customers a PaaS-based delivery option for automation-driven, single pane analytics, providing
log management, analytics, and reporting for Fortinet NGFW and SD-WAN with an easily accessible cloud-based solution.
FortiAnalyzer Cloud delivers reliable real-time insights into network activity with extensive reporting and monitoring for clear,
consistent visibility of an organization’s security posture. Customers can easily access their FortiAnalyzer Cloud from their
FortiCloud single sign-on portal.

Virtual Offerings

FortiAnalyzer VM Subscription

The FortiAnalyzer VM Subscription license model consolidates into one single SKU: VM product SKU, FortiCare Support SKU,
FortiGuard I0C and Outbreak Detection Service, Security Automation services, to simplify the product purchase, upgrade,

and renewal. FortiAnalyzer-VM S provides organizations with centralized security event analysis, forensic research, reporting,
content archiving, data mining, malicious file quarantining, and vulnerability assessment. Centralized collection, correlation, and
analysis of geographically and chronologically diverse security data from Fortinet and third party devices deliver a simplified,
consolidated view of your security posture.

The FortiAnalyzer-VM S series SKUs come in stackable 5, 50, and 500 GB/ day logs licenses, so that multiple units of this SKU
can be purchased together providing organizations with the ability and cost-efficiencies to scale and meet their logging needs.

FortiAnalyzer VM

Fortinet offers the FortiAnalyzer-VM licensing in a stackable perpetual license model with a-la-carte technical support and
subscription services.

This software-based version of the FortiAnalyzer hardware appliance is designed to run on many virtualization platforms, which
allows you to expand your virtual solution as your environment expands.

FAZ-VM-GB500 FAZ-VM-GB2000

FORTIANALYZER VIRTUAL APPLIANCES FAZ-VM-GB1 FAZ-VM-GB5 FAZ-VM-GB25

Capacity
GB/ day of Logs * +1 +5 +25 +100 +500 +2000
Devices/VDOMs Maximum 10 000 10 000 10 000 10 000 10 000 10 000
FortiGuard I0C Service @
Security Automation Service @
Hypervisor Support Up-to-date hypervisor support can be found in the release note for each FortiAnalyzer version.
Visit https://docs.fortinet.com/product/fortianalyzer/ and find the Release Information at the bottom section.

Go to "Product Integration and Support” - “FortiAnalyzer [version] support” - “Virtualization”
vCPU Support (Minimum / Maximum) 4 / Unlimited
Network Interface Support (Min / Max) ** 1712
Memory Support (Minimum / Maximum) 16 GB / Unlimited for 64-bit
*Unlimited GB/ day when deployed In collector mode. p. e ¢ U‘
** VM supports up to 12 vNIC interfaces/ports. Applicable to 6.4.3+. Actual cors vI‘e{ ﬁﬁmpey&ﬁry depending on cloud platforms

B
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Specifications
} ,l; Cas: {757 wm) s R
FORTIANALYZER APPLIANCES FAZ-150G FAZ-300G
Capacity and Performance
GB/ day of Logs 25 100 200 660
Analytic Sustained Rate (logs/
sec)* 500 2000 4000 20 000
Coll)zictor Sustained Rate (logs/ 750 3000 5000 30 000
sec
Devices/VDOMs (Maximum) 50 180 800 2000
Max Number of Days Analytics** 90 50 50 80
Options
FortiGuard |OC and Outbreak
Detection Service @ @ @ @
Security Automation Service ©) ® ) ©
Enterprise Bundle @ @ @ @
Hardware Bundlie @ @ @ @
OT Security Service @ @ @ @
Security Rating and Compliance
Service @ @ @ @
Hardware Specifications
Form Factor (supports EIA/non- Desktop 1RU Rackmount 1 RU Rackmount 2 RU Rackmount
ElA standards)
Total Interfaces 2% RJ45 GE 4x RJ45 GE 4x RJ-45 2x GE SFP 2% 2.5GbE RJ45 + 2x 25GbE SFP28
Storage Capacity 47B (2% 2T8) 8 TB (2% 4 TB) 16TB (4x 4TB) 3.5 in SAS HDDs 32 TB (8 x 4T8B) 3.5 in SAS SED
HDD

Usable Storage (After RAID) 27B 478 8T8 2478
Removable Hard Drives No No @ @
RAID Levels Supported on RAID 0/1 RAID 0/1,1s/5,5s/10 RAID 0/1/5/6/10/50/60
RAID Type Software Software Hardware /| Hot Swappable Hardware / Hot Swappable
Default RAID Level 1 1 10 50
Redundant Hot Swap Power No Optional
Supplies Optional @
Trusted Platform Module (TPM) *** Gen 2 Gen 2 ©) ©
Dimensions
Height x Width x Length {inches) 95x%x35x8 1.73 % 17.24 % 16.38 1.73 x 17.32 x 21.65 3.46 x 17.24 x 24.41
Height x Width x Length (cm) 241 % 8.9 x 20.55 4.4 %438 x 418 4.4 x 440 % 55.0 8.8 x43.8x620
Weight 9.35 Ibs (4.24 kg) 22.5 Ibs (10.2 kg) 25.75 Ibs (11.68 kg) 496 |bs (22.5 kg)
Environment
AC Power Supply 100-240V AC, 50-60 Hz 100-240V AC, 60-50 Hz 100-240Vac, 50~60Hz, 4A max 100-240Vac, 50~60Hz, 4A max
Power Consumption (Average / 36 W /43 W 901W /99 W 115W /150W 251.36W / 302W
Maximum)
Heat Dissipation 147.4 BTU/h 337.8 BTU/h 433 8TU/h 857.73 BTU/h
Operating Temperature 32°F t0 104° F {(0°C to 40° C) 32°F to 104° F (0°C to 40° C) 32°F to 104° F (0°C to 40° C) 32°F to 104° F (0°C to 40° C)
Storage Temperature -4°F t0 167° F (-20°C to 75° C) -13°F to 167° F (-25°C to 75° C) -4°F to 167° F (-20°C to 75° C) -40°F t0 158° F (-40°C to 70° C)
Humidity 5% to 95% non-condensing 20% to 90% non-condensing 5% to 95% non-condensing 5% to 95% non-condensing
Forced Airflow Front to Back Front to Back Front to Back Front to Back
Operating Altitude Up to 7400 ft (2250 m) Up to 7400 ft (2250 m) Up to 7400 ft (2250 m) Up to 16 404 ft (5000 m)
Compliance iLv . i i %
Safety Certifications FCC Part 15 Class A, RCM, VCCI, FCC Part 15}d}9§s’ RCM, VCCI,: FCC Part 15 Class A, RCM, VCCI, FCC Part 15 Class A, RCM, VCC],

Y CE, UL/cUL, CB CE, BSM|, K§ uL/ett, CBGO:ST‘ : CE, UL/cUL, CB CE, UL/cUL, CB

* Sustained Rate - maximum constant log message rate that the FAZ platform can maintain for minimum 48 hou.r ’without SQL database and system performance degradation.
#* The maximum number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate is lower.

*#** Gen2 refers to hardware that has been upgraded since initial release.
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Specifications

T3
FORTIANALYZER APPLIANCES FAZ-3100G

Capacity and Performance
GB/ day of Logs

Analytic Sustained Rate
(logs/sec)*

Collector Sustained Rate
(logs/sec)*

Devices/VDOMs (Maximum)
Max Number of Days Analytics**
Options

FortiGuard I0C and Outbreak Detection
Service

Security Automation Service

Enterprise Bundle

Hardware Bundle

OT Security Service

Security Rating and Compliance Service
Hardware Specifications

Form Factor (supports EIA/non-EIA
standards)

Total Interfaces

Storage Capacity

Usable Storage (After RAID)
Removable Hard Drives

RAID Levels Supported

RAID Type

Default RAID Level

Redundant Hot Swap Power Supplies
Trusted Platform Module (TPM) ***
Dimensions

Height x Width x Length (inches)
Height x Width x Length {(cm)
Weight

Environment

AC Power Supply

Power Consumption (Average/Max)
Heat Dissipation

Operating Temperature

Storage Temperature

Humidity

Forced Airflow

Operating Altitude

Compliance

Safety Certifications

OO ®

3 RU Rackmount

2% GE RJ45, 2x 25GE SFP28

84 TB (16 x 4TB) 3.5" SAS SED HDD + 3.84

(2% 1.92TB) 2.5" NVMe SSD
56 T8

@

RAID
0/1,1s/5,5s/6,85/10/50/60

Hardware / Hot Swappable
50

52x172x255
13.0 x 44.0 x 65.0
69.6 Ibs (31.57 kg)

100-127V~/10A, 200-240V~/5A
395W /510 W
174019 BTU/h
32°F to 104°F (0°C to 40°C)
-4°F to 158°F (-20°C to 70°C)
5% to 95% (non-condensing)
Front to Back |
Up 1013 123 ft (4000 mf |

1

FCC Part 15 Class A, RCM, VCCI{CE, UL/

cUL, CB

FAZ-3510G

5000

60 000

90 000

10 000

QOO ®

4 RU Rackmount

2% 10GDE RJ45, 2x 25GbE SFP28

24x ATB (96TB) + 2x 3.84TB (7.68TB)

8478

@

RAID
0/1,1s/5,5s/8,6s/10/50/60

Hardware / Hot Swappabie
50

@
©

7x172x 275
178 x 43.7 x 69.9
85 Ibs (29.5 kg)

100-127V~/10A, 200-240V~/5A
983 W /1278 W
3424 BTU/h
32°F to 104°F (0°C to 40°C)
-4°F to 167°F (-20°C to 75°C)
5% to 95% (non-condensing)

Front to Back

v i cuL, CcB

Part 15 Class A, RCM, VCCI, CE, UL/

Data Sheet

8300

100 000

150 000

10 000
60

QOO ©

4 RU Rackmount

2x 10GE RJ-45 + 2x 25GE SFP28

240TB (60% 4TB) 3.5 in HDD + 19.2TB
(6% 3.2TB) NVMe SSD

22478

@

RAID
0/1,15/5,5s/6,6s/10/50/60

Hardware / Hot Swappable
50

7.0 x17.2 x 30.2
178 x 43.7 x 76.7
118 Ibs (53.5 kg)

2000W ACH#*+*
850 W /1423.4 W
4858 BTU/h
50°F to 95°F (10°C to 35°C)
-40°F to 158°F (-40°C to 70°C)
8% to 90% (non-condensing)
Front to Back
Up to 7400 ft (2250 m)

FCC Part 15 Class A, RCM, VCCI, CE, UL/

cUL, CB

* Sustained Rate - maximum constant log message rate that the FAZ platform can maintain for minimurf 48 hours without SQL database and system performance degradation.

**1s the max number of days if receiving logs continuously at the sustained analytics log rate. This number can increase if the average log rate is lower,

*** Gen?2 refers to hardware that nas been upgraded since initial release.

*=x*3700G must connect to a 200V - 240V power source.
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FortiAnalyzer

Ordering Information

Product

FortiAnalyzer

FortiAnalyzer-VM Subscription
License with Support

FortiAnalyzer-VM

FortiAnalyzer Cloud Storage
Subscription

FortiAnalyzer - Backup to Cloud
Service
FortiAnalyzer Cloud with SOCaa$S

FortiAnalyzer Cloud

Security Automation Service

FortiGuard IOC and Outbreak
Detection Service

OT Security Service

FortiAnalyzer Security Rating and
Compliance Service

Enterprise Protection Bundle

Hardware Bundle

SKU

FAZ-150G
FAZ-300G
FAZ-810G

FAZ-1000G

FAZ-3100G

FAZ-3510G

FAZ-3700G

FC1-10-AZVMS-465-01-DD

FC2-10-AZVMS-465-01-DD

FC3-10-AZVMS-465-01-DD

FAZ-VM-GB1
FAZ-VM-GBS
FAZ-VM-GB25
FAZ-VM-GB100
FAZ-VM-GBS500

FAZ-VM-GB2000
FC1-10-AZCLD-463-01-DD

FC2-10-AZCLD-463-01-DD

FC3-10-AZCLD-463-01-DD

FC-10-FAZ00-286-02-DD

FC-10-[Model Code]-464-02-DD

FC-10-[Model Code]-585-02-DD

FC-10-[Model Code]-335-02-DD
FCIGB Day Code]-10-LVOVM-335-02-DD
FC-10-[Model Code]-661-02-DD
FCIGB Day Code]-10-LVOVM-861-02-DD
FC-10-[Model Code]-159-02-DD

FC-10-[Model Code]-175-02-DD

FC-10-[Model Code]-466-02-DD

FAZ-[Hardware Model]-BDL-466-DD

Data Sheet

Description
Centralized log and analysis appliance — 2x RJ45 GE, 4 TB storage, up to 25 GB/ day of logs.
Centralized log and analysis appliance — 4x RJ45 GE, 8 TB storage, up to 100 GB/ day of logs.

Centralized log and analysis appliance — 4x GE, 2x SFP, 16 TB self-encrypting storage, up to
200 GB/ day of logs.

Centralized logging and analysis appliance - 2x 2.5GbE RJ45 + 2x 25GbE SFP28, 32TB storage, up to
660 GB/Day of Logs.

Centralized log and analysis appliance — 2x GE RJ45, 2x 25GE SFP28, 64 TB storage, dual power
supplies, up to 3000 GB/ day of logs.

Centralized log and analysis appliance — 2x 10GbE RJ45, 2x 25GbE SFP28, 96 TB storage, up to
5000 GB/ day of logs.

Centralized log and analysis appliance - 2x 10GE RJ-45 + 2x 25GE SFP28 slots, 240TB HDD + 19.2TB
NVMe SSD storage, up to 8300 GB/ day of Logs.

Subscription ficense for 5 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
|0C, Security Automation Service, and FortiGuard Outbreak Detection service.

Subscription license for 50 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Qutbreak Detection service.

Subscription license for 500 GB/Day Central Logging and Analytics. Include FortiCare Premium support,
10C, Security Automation Service, and FortiGuard Outbreak Detection service.

Upgrade license for adding 1 GB/Day of Logs.
Upgrade license for adding 5 GB/Day of Logs.
Upgrade license for adding 25 GB/Day of Logs.
Upgrade license for adding 100 GB/Day of Logs.
Upgrade license for adding 500 GB/Day of Logs.

Upgrade license for adding 2 TB/Day of Logs.

Increase FortiAnalyzer Cloud storage by 5 GB/Day for Central Logging and Analytics and FortiCloud
SOCaasS. Include FortiCare Premium support, IOC and Security Automation Service.

Increase FortiAnalyzer Cloud storage by 50 GB/Day for Central Logging and Analytics and FortiCloud
SOCaaS. Include FortiCare Premium support, IOC and Security Automation Service.

Increase FortiAnalyzer Cloud storage by 500 GB/Day for Central Logging and Analytics and FortiCloud
SOCaaS. Include FortiCare Premium support, IOC and Security Automation Service

One year subscription to FortiAnalyzer storage connector service for 10TB data transfer to public cloud.

FortiAnalyzer Cloud with SOCaa$: cloud-based central logging and analytics. Include All FortiGate log
types, I0C service, Security Automation Service, FortiGuard Outbreak Service and SOCaaS.

FortiAnalyzerCloud: cloud-based central logging and analytics. Include all FortiGate log types, I0C
service, Security Automation Service, FortiGuard Outbreak Detection Service.

Subscription license for Security Automation Service - Appliance.

Subscription license for Security Automation Service - Virtual Machine.

Subscription license for FortiGuard IOC and Outbreak Detection Service - Appliance.
Subscription license for FortiGuard I0C and Outbreak Detection Service - Virtual Machine.

OT Security Service including advanced OT analytics, risk and compliance reports, event handlers, and
use-case correlation rules.

Subscription license for FortiAnalyzer Security Rating and Compliance Service.

Enterprise Protection (FortiCare Premium plus Indicators of Compromise Service, Security Automation
Service, and FortiGuard Outbreak Detection service).

Hardware plus FortiCare Premium and FortiAnalyzer Enterprise Protection.
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Fortinet Corporate Social Responsibility Policy

Fortinet is committed to driving progress and sustainability for all through cybersecurity, with respect for human rights and
ethical business practices, making possible a digital world you can always trust. You represent and warrant to Fortinet that you
will not use Fortinet’s products and services to engage in, or support in any way, violations or abuses of human rights, including
those involving illegal censorship, surveillance, detention, or excessive use of force. Users of Fortinet products are required

to comply with the Fortinet EULA and report any suspected violations of the EULA via the procedures outlined in the Fortinet
Whistleblower Policy.
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Setting up FortiAnalyzer

Avatars

When FortiClient sends logs to FortiAnalyzer, an avatar for each user can be displayed in the Source column in the
FortiView and Log View panes. FortiAnalyzer can display an avatar when FortiClient is managed by FortiGate or
FortiClient EMS with logging to FortiAnalyzer enabled.

« When FortiClient Telemetry connects to FortiGate, FortiClient sends logs (including avatars) to FortiGate, and the
logs display in FortiAnalyzer under the FortiGate device as a sub-type of security.
The avatar is synchronized from FortiGate to FortiAnalyzer by using the FortiOS REST AP

o When FortiClient Telemetry connects to FortiClient EMS, FortiClient sends logs (including avatars) directly to
FortiAnalyzer, and logs display in a FortiClient ADOM.

—~ 15

If FortiAnalyzer cannot find the defined picture, a generic, gray avatar is displayed.

ALY
‘9' You can also optionally define an avatar for FortiAnalyzer administrators. See

Creating administrators on page 351.

Showing and hiding passwords

In some cases you can show and hide passwords by using the toggle icon. When you can view the password, the Toggle
show password icon is displayed:

Password test (g

When you can hide the password, the Toggle hide password icon is displayed:

Password |oses w

Target audience and access level

This guide is intended for administrators with full privileges, who can access all panes in the FortiAnalyzer GUI, including
the System Settings pane.

In FortiAnalyzer, administrator privileges are controlled by administrator profiles. Administrators who are assigned
profiles with limited privileges might be unable to view some panes in the GUI and might be unable to perform some
tasks described in this guide. For more information about administrator profiles, see Administrator profiles on page 358.

administrator profile, which is assigned to the admin account by default and gives the admin

s‘é’, If you logged in by using the admin administrator account, you have the Super_User
= administrator full privileges.

Initial setup

This topic provides an overview of the tasks that you need to do to get your FgrtiAnaIyzer unit up and running.

FortiAnalyzer 7.2.2 Administration Guide 27
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FortiAnalyzer Key Concepts

) : ’, ADOMs must be enabled to support FortiCarrier, FortiClient EMS, FortiMail, FortiWeb,
9 FortiCache, and FortiSandbox logging and reporting. See Administrative Domains (ADOMSs)
= on page 296.

Logs

Logs in FortiAnalyzer are in one of the following phases.

+ Real-time log: Log entries that have just arrived and have not been added to the SQL database. These logs are
stored in Archive in an uncompressed file.

» Archive logs: When a real-time log file in Archive has been completely inserted, that file is compressed and
considered to be offline.

= Analytics logs or historical logs: Indexed in the SQL database and online.

In order for FortiAnalyzer to accept logs, the sending device must be registered in FortiAnalyzer. You can add devices to
FortiAnalyzer by specifying the serial number and other details, or you may point the device’s log settings to the
FortiAnalyzer. If initiated by the remote device, the device must be authorized before logs can be received on
FortiAnalyzer. See Adding devices on page 41.

For more information on the types of logs collected for each device, see Types of logs collected for each device on page
88.

Log encryption

Beginning in FortiAnalyzer 6.2, all logs from Fortinet devices (using Fortinet's proprietary protocol: OFTP) must be
encrypted. FortiAnalyzer encryption level must be equal or less than the sending device's level. For example, when
configuring logging from a FortiGate, FortiAnalyzer must have the same encryption level or lower than FortiGate in order
to accept logs from FortiGate.

To configure the encryption level on FortiAnalyzer:

1. Inthe FortiAnalyzer CLI, enter the following commands:
config system global
set enc-algorithm {high | low | medium}

To configure the encryption level on FortiGate:

1. Inthe FortiGate CLI, enter the following commands:
config log fortianalyzer setting
set enc-algorithm {high-medium | high | low}

See also Appendix B - Log Integrity and Secure Log Transfer on page 405.

Log storage

Logs and files are stored on the FortiAnalyzer disks. Logs are also temporarily stored in the SQL database.

FortiAnalyzer 7.2.2 Administration Guide
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FortiView dashboards for FortiGate and FortiCarrier devices

| Threats

Top Threats

. Description

Lists the top threats to your network.

The followmg mcrdents are conSIdered threats
. Rlsk appllcatjons detected by appltcatlon control
« Intrusion mcrdents detected by IPS.
. Mahcnous web sites detected by wab ﬁltenng
e Malwarelbotnets detected by antlwrus

Threat Map

Displays a map of the world that shows the top traffic destinations starting
at the country of origin. Threats are displayed when the threat score is
greater than zero and either the source or destination IP is a public IP
address.

The Threat Window below the map, shows the threat, source, destination,
severity, and time. The color gradient of the lines indicate the traffic risk. A
yellow line indicates a high risk and a red line indicates a critical risk.

This view does not support filtering and Day, Night, and Ocean themes.
See also Viewing the threat map on page 58.

Compromised Hosts

|

Displays end users with suspicious web use compromises, including end

users’ IP addresses, overall threat rating, and number of threats.

To use this feature:

1. UTM logs of the connected FortiGate devices must be enabled.

2. The FortiAnalyzer must subscribe to FortiGuard to keep its threat
database up-to-date.

| FortiSandbox
| Detection

Displays a summary of FortiSandbox related detections.

The following information is displayed: Filename, End User and/or IP,
Destination IP, Analysis (Clean, Suspicious or Malicious rating), Action
(Passthrough, Blocked, etc.), and Service (HTTP, FTP, SMTP, etc.).

Select an entry to view additional information in the drilldown menu.
Clicking a FortiSandbox action listed in the Process Flow displays details

about that action, including the Overview, Indicators, Behavior Chronology

Chart, Tree View, and more. Information included in the Details and Tree
View tab is only available with FortiSandbox 3.1.0 and above.

FortiAnalyzer 7.2.2 Administration Guide
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Category

Top Sources

Description

Displays the highest network traffic by source IP address and interface,
device, threat score (blocked and allowed), sessions (blocked and
allowed), and bytes (sent and received).

Top Sotire
Addresses

Urce addresses by source object lnterface dewce
,d allowed), sessions (blocked and allowed) and
bytes (sent and reoewed)

Displays the highest network traffic by destination IP addresses, the

~ 8 Tob Destinations applications used to access the destination, sessions, and bytes. If
| . P available, click the icon beside the IP address to see its WHOIS
 Traffic information.
£ g i tlon addresses by destrnahon objects
; ti i
:gzrlz::égaﬂon ¢ nd-,bytes if aval!able click the icon beside the IP
SRR address to see its WHOIS information.
. Displays the highest network traffic by country in terms of traffic sessions,
T t -
op Country/Regian including the destination, threat score, sessions, and bytes. i
Policy Hits Lists the policy sessions by policy, device name, VDOM, number of hits,
j 4 bytes, and last used time and date.
‘: DNS Logs | Summarizes the DNS activity on the network. Double click an entry to drill
9 down to the specific details about that domain.
ZTNA Servers ZTNA servers by bytes.
Displays the top cloud applications used on the network. !
St T Top Cloud When viewing information about an application, FortiAnalyzer will first ‘
adow Applications check the Shadow IT database, and if no results are found, it will use the
metadata.
Top Cloud Users Displays the top cloud users on the network.
Dlsplays the. top appllcatlons used on the network mcludlng the application
name, category, risk level -and sessions blocked and allowed. Bytes sent |
— .3 Ton Applicati and received can also be enabled through the widget settings. Top ;
SR RRpHCatcns Applicatlons can be vrewed asa stackbar, bar, table, or bubble chart. |
For a usage exarnple, see Finding application and user information on l
page 68.
Applications & - -
 Websites Ezfn:ﬁ:s“e Displays the top allowed and blocked website domains on the network.
Top Website 2 ; SR A ‘
Catégaries Displays the top website categories. ;

Top Browsing' Users

Displaye the top web-browsing users, lncludihg source, group, number of
sites visited, browsing time, and number of bytes sent and received.

FortiAnalyzer 7.2.2 Administration Guide
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Category

Description

Displays the users who are accessing the network by using the following |
types of security over a virtual private network (VPN) tunnel: secure socket
layers (SSL) and Internet protocol security (IPsec). |
1 SSL & Dialup IPsec | You can view VPN traffic for a specific user from the top view and drilldown |
VPN views. In the top view, double-click a user to view the VPN traffic for the
s specific user. In the drilldown view, click an entry from the table to display
the traffic logs that match the VPN user and the destination.
Site-to-Site |Psec Displays the na.mes of VPN tunnels with Internet protocol security (IPsec)
that are accessing the network.
Admin Logins Displays the users who logged into the managed device.
- 8 System Events Displays events on the managed device.
Displays device CPU, memory, logging, and other performance
‘ _ information for the managed device.
| System Resource Usage . .
i 5 Resource Usage includes two widgets: Resource Usage Average and
Resource Usage Peak.
Failed : . .
; L | Displays the IP addresses of the users who failed to log into the managed
+ Authentication i .
| | device.
- Attempts ,

Using FortiView

When ADOMs are enabled, FortiView displays information for each ADOM. Please ensure you are in the correct ADOM.
See Switching between ADOMs on page 26.

Viewing FortiView dashboards

Viewing FortiView dashboards on page 57

Filtering FortiView on page 59
Viewing related logs on page 59

Exporting filtered summaries on page 59

Monitoring resource usage of devices on page 60

Long-lived session handling on page 60

When viewing FortiView dashboards, use the controls in the toolbar to select a device, specify a time period, refresh the
view, and switch to full-screen mode.

Many widgets on FortiView dashboards let you drill down to view more details. To drill down to view more details, click,
double-click, or right-click an element to view details about different dimensions in different tabs. You can continue to dfrill
down by double-clicking an entry. Click the close icon in the widget's toolbar to return to the previous view.

Many FortiView widgets support multiple chart types such as table view, bubble view, map view, tile view, etc.

« Inwidgets that support multiple views, select the settings icon in the top-right corner of the widget to choose another

view.

FortiAnalyzer 7.2.2 Administration Guide
Fortinet Inc.

pagel5

57



SD-WAN Bandwidth
Overview

SD-
WAN Performance
Status

SD-WAN Rules
Utilization

SD-WAN Utilization
by Application

— 11

Health Check Status

SD-WAN Events

Application
Bandwidth
Utilization

Per-Application
Performance

Global-Application
Performance

SD-WAN Interfaces

Audio MOS Score

The bandwidth of the SD-WAN network over time. This widget displays a line chart of the
sent/received rate (bps) in the selected time period for SD-WAN members interfaces.

The SD-WAN performance status comparison with interfaces. Mousing over the scatter
chart displays the status for health checks and member interface in a tooltip. The colors (red,
orange, yellow, and green) indicate the different percentage of a member's interface or
health check. Click on a scatter chart to view additional details.

The SD-WAN rule traffic utilization by interface and application.
The share of bandwidth utilization by application for each WAN link.

This wudget dynamxcally creates a chlld- ldget for each health check where aline chart of
latency, jlttel’ and packet loss in the selected time period for SD-WAN interfaces is
displayed.

This widget displays a table chart for SD-WAN event logs which have a level higher than
notice (warning, error, efc.) within the selected time period.

The total bandwidth from all applications as well as the bandwidth per-SD-WAN interface.
This widget can be viewed in a sanky chart or table chart format.

The performance for the selected application based on chosen metric. You can select an
application in the widget's Application dropdown menu.

Latency, Jitter, Packet Loss, and Bandwidth metrics are available.

The global application performance for the selected metric.
Latency, Jitter, and Packet Loss metrics are available.

The information for SD-WAN interfaces and ADVPN shortcut interfaces.

Latency, Jitter, and Packet Loss metrics are available.

The MOS score by interface. Mousing over the chart displays a summary of the MOS score
and VolP quality at that point.

The interface must have a performance SLA with MOS enabled to display in the chart.

R

To update the Refresh Interval, click the settings icon at the top of the widget, and then select a
value from the dropdown.

To filter a chart, click a key in the legend.

SD-WAN Summary

SD-WAN Summary monitor includes the folldwmg wxdgets j

SD-WAN Health Overview

The SD WAN devncis status.

FortiAnalyzer 7.2.2 Administration Guide
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Log View and Log Quota Management

device(s) and time frame for the event logs.

The Total Events widget on this dashboard displays a line chart of event logs by level. You can hover your cursor over
the line chart to display a summary of the count and time at that point.

The other widgets on this dashboard list the event names for the displayed event types. These widgets can be toggled
on/off from the Toggle Widgets dropdown. By clicking an event name in the widget, you can open a list view of those
event logs filtered by the devices and time frame you selected on the dashboard.

IS PR i ]

Total Events
O nfsmmator - nctics o warming  aror

2022/02/10 16:20
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X { ’\ & @ notice 309
"'\\ ’\/A‘\/-“—\ ;r\\_//\\ o i ,// Ll Swaming 45 |
. \ ] \/ W  error 0

VPN Events

* View svents rsating to VPN %
Event Name | Lavel Count
W Psec unnel s notice 20—
-} notice 168 o—
- notice 108 p—
f— notice 108 —
- sotice 5 -
- notice 2 =
LI | notice i@ .
u enor 19 '
1 erter f
S information 1 ]
@ SD-WAN Events & User Events 5
it oerts refsting 1 ST AN, Viewe mais velanes 19 s
Event Name Level Count Event Name. Level Count
SDWAN statos notics 5617 —— No record found.

Viewing historical and real-time logs

By default, Log View displays historical logs. Custom View and Chart Builder are only available in historical log view.
To view real-time logs, in the log message list view toolbar, click Tools > Real-time Log.

To switch back to historical log view, click Tools > Historical Log.

Viewing raw and formatted logs

By default, Log View displays formatted logs. The log view you select affects available view options. You cannot
customize columns when viewing raw logs.

To view raw logs, in the log message list view toolbar, click Tools > Display Raw.
To switch back to formatted log view, click Tools > Formatted Log.

For more information about FortiGate raw logs, see the FortiGate Log Message Reference in the Fortinet Document
Library. For more information about raw logs of other devices, see the Log Message Reference for the platform type.

FortiAnalyzer 7.2.2 Administration Guide
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Incident and Event Management

Option Description

e Match Criteria: Select an opérator from the dropdown.
* Value: Select the event type from the dropdown.
To delete a condition, click the delete icon next to the condition.

Generic Text Filter  (Optional) Enter<ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>